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Conventions Used in this Manual 

 

This warning icon indicates a potential for damage to equipment, personal injury 

or data loss.  

 
A note icon indicates an important point to remember. 
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1.0 Introduction 

The 600A Digital Controller was designed to enable physiology researchers to study the 

dynamic mechanical characteristics of muscle tissue.  The system is capable of controlling and 

taking data from all of our 300C series muscle levers, our 400A series of force transducers, our 

700A series of stimulators, our 800A series of apparatus and our 900A series of sarcomere length 

systems.  The 600A can also be used with other manufacturer’s instruments.   

 

A unique feature of our 600A is its capability of controlling force or sarcomere length.  In 

order to control force the 600A adjusts the length of the preparation to provide the desired force.  

This force control mode can generate critically damped step changes in force in as little as 1.0 

millisecond.  When controlling sarcomere length the 600A must be paired with an ASI HVSL 

(High speed Video Sarcomere Length) system which provides the sarcomere length signal.  Just 

as with force control, 600A adjusts the length of the preparation to provide the desired sarcomere 

length. 

 

The 600A Digital Controller is a complete data acquisition and control system that 

consists of: custom software for data acquisition, instrument control and data analysis, a 

computer (PC) running a real-time version of Linux, a data acquisition card, a model 604A 

Signal Interface and all required interconnecting cables.  

 

 The 600A software has an easy-to-use graphical user interface that collects high-

resolution length and force data while controlling the length and force of the muscle tissue under 

test.  The 600A software can also log sarcomere length (SL) data and up to two other analog 

input channels. Collected data can then be plotted and analyzed within the program.  The 600A 

program also includes a real-time scrolling display that can be configured to show length, force, 

SL or the auxiliary analog input channels.  This scrolling display can be frozen at any time and 

then up to 4 hours of data can be reviewed.   

 

A unique feature of the 600A Digital Controller is that the PC uses a real-time version of 

the Linux operating system.  The real-time operating system maintains control over all time-

critical data acquisition and control tasks with a timing accuracy of better than 10 microseconds, 

regardless of what other programs and processes are being run on the computer. This is not the 

case with other PC or Apple operating systems such as Windows, DOS or the Apple OS.    

 

The PC supplied with the 600A system features a compact tower case, a 64x6 six-core 

processor, 4 GB RAM, large hard disk and a built-in Ethernet adapter.  Included within the PC is 

a high-speed data acquisition card.  The card features 16-bit accuracy on the eight differential 

analog input channels (A/D) and on the two analog output channels (D/A).  The use of a 16-bit 

A/D and D/A ensures that the 600A Digital Controller measures and controls length and force to 

the resolution of our instruments.  The A/D card also provides control of a stimulator and the 

ability to trigger other instruments. 

 

A model 604ASignal Interface is included with the system.  This interface allows the 

researcher to easily connect a length controller, a force transducer and a stimulator to the A/D 

system.  The 604A is housed in a 19” rack-mount case that is 1U (1.75”) high.  All connections 
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to the A/D card are available via front panel-mounted BNC connectors.  In order to make the 

system as “turn-key” as possible we have also included BNC to BNC patch cables to make the 

necessary connections between a length controller, a force transducer, a stimulator and the 600A 

Digital Controller.   

 

1.1 What’s New in Version 3.000 

Version 3.000 of the 600A Program comes with many new features and improvements.  

Some of the key improvements are a completely redesigned and upgraded Force and SL Control 

system, increased data acquisition and control speed, new automatic protocol checking to help 

avoid common mistakes, channel colours that are persistent across all graphs, and new light and 

dark themes for the graphs.   

Redesigned Force and SL Control 

  The Force and SL Control window has been completely redesigned with great 

improvements to the functionality, stability and ease of use. One of the biggest improvements is 

the new feedback control algorithm which provides far more stable control of either force or 

sarcomere length and also provides an easy-to-use tuning interface. Another new feature is that 

the feedback control parameters can be changed at any time, even in the middle of a protocol.  

This makes it much easier to setup the force and sarcomere length control.  Section 5 provides 

greater detail of the new Force and SL Control. 

Increased Sample Rate 

 The sample rate of the program has increased from 10,000 samples per second to 20,000 

samples per second. This allows the users to sample up to four channels and save the data to file 

at a rate of 20 kHz.  This increased data rate is also available for control outputs thus providing 

an increase in performance of the control section of the program. 

Protocol Auto-Checking  

 The protocol window now contains auto-checking functionality which looks for common 

mistakes and warns the user.  An example of this is the auto-checking routine will detect when a 

protocol command is programmed to start before the previous command has finished executing.  

Burst Window 

 Burst is a completely new function in version 3.000. It allows the user to sample data at 

the maximum speed of the A/D card (250,000 Hz). This increases the normal maximum rate of 

20,000 samples per second to 60,000 samples per second on four channels. This is very useful 

when tuning a high speed length controller or capturing a transient event. 

Plot Themes 

 Two plot themes are available in the new version with the addition of a dark theme along 

with the standard white background theme.  The dark theme replaces the black lines on white 

background of the original light theme, with green lines on a black background. This setting 

provides more options when displaying your data and generally makes it easier to see the data.  
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Display Colours 

The Display Settings window has changed to accommodate colours that are persistent to 

a channel as opposed to a graph. As an example if SL is set to blue then it will show as blue on 

all plots (Main window, Scope, and Analysis) even after the program has been restarted. 

Protocol Menu 

Changes in the menu structure in the protocol window have been made in order to make 

it easier to navigate the growing list of functions. The functions are now broken up into 

subcategories of Length, Force, SL, Stim, and Control. 
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2.0 Specifications 

Model: 600A Digital Controller 

Personal Computer 

Processor:   3.3 GHz AMD 64x6 

RAM:    4 GB 

Hard Disk:   500 GB 

DVD ROM:   DVD-R, CD-R 

USB Flash Disk:  4 GB 

Ethernet Card:   1 Gbit/sec 

Keyboard:   USB type, 101 key 

Mouse:   USB type, Microsoft compatible. 

Power Requirements:  120/240VAC 10%, 50/60Hz, 5 amps max., switch selectable. 

Dimensions:   mini-tower case. 

Weight:   4 kg. 

A/D Card 

Analog Input 

Number of Channels:  8 differential 

Resolution:   16 bits (1 part in 65535) 

Maximum Sampling Rate: 250,000 samples per second 

Analog Output 

Number of Channels:  2 

Resolution:   16 bits (1 part in 65535) 

Maximum Output Rate: 833,000 updates per second 

Digital Input/ Output 

Number of Channels:  24 

Type:    TTL 

 

Interface:   68 conductor ribbon cable 

Dimensions:    PCI Bus 

604A/C A/D Signal Interface 

Input Connector Type: BNC – isolated, male 

Number of A/D Inputs: 8: Length In, Force In, Aux 1-6 

Number of D/A Outputs: 2: Length Out, Force Out 

Digital I/O:   2 Inputs: Trg In 1, Trg In 2 

4 Outputs: Trg Out 1, Trg Out 2, Stimulator, Inhibit 

Operating System 

Type:    Linux - RTAI real-time  

Kernel:   2.6.37.6-rt 

Interface:   GUI (Windows-type) 

ASI600A Software  

Version:   3.000 

RTAD Version:  3.00  
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Programming Language: C 

Interface:   GUI (Windows-type), drop down menus 

Main Window Menu  

File:  Save Data, Exit 

Edit:  Display Settings, Show Controls 

Calibrate:  Models Attached, Length, Force, Force and SL Control 

Setup:  Open, Close 

Protocol:     Open, Close 

Analysis:   Open, Close 

Scope:   Open, Close 

Burst:   Open, Close 

Help:    ASI600A Help, About 

Protocol Window  

Protocol Functions 

Length:   Step, Ramp, Square, Sine, Sweep, Sample, Hold, Read Larb, Write 

Larb, Send Larb, Larb 

Force:    Step, Ramp, Square, Sine, Sweep, Sample, Hold, Clamp 

SL:    Step, Ramp, Sample, Hold, Trigger, Track    

Stim:    Stimulus, Trigger 1, Trigger 2 

Control:   Data Enable, Data Disable, Data Burst, Bath, Repeat, Stop  

Stimulus Tab  

Profile 1-10:  Pulse Width, Pulse Frequency, Frequency Duration, Train 

Frequency, Train Duration.   

Sequencer Tab   

Sequencer Window: Clear Sequence, Verify Sequence, Load, Save As, Save. 

Settings:  Sequence File, Protocol File Directory, Data File Directory, 

Sequence Number, One Data File per Frame or Test.  

Sequence:  Enable, Protocol File Name, Browse, Delay Time, Data File Name, 

File Status. 

Analysis Window    

File:    Load Data, Load Current, Export Data, Close 

Signals In:   Length (L), Force (F), Velocity (V), dF/dt, SL, Aux1, Aux2  

Signals Out:  Length (L), Force (F), Velocity (V), dF/dt, SL, Stimulus-Triggers 

(Stim), Digital Readout (readout) 

Unit Controls:   Length [um, mm, cm, Lo, Lf, volts],  

   Force [mN, N, gm, kg, Fmax, Pa, kPa, volts], 

   Time [ms, s] 

Plot Zoom Controls:  T Start, T End, un-zoom data (Unlock T) button.  User can zoom 

by using the cursor to select an area on the graph to zoom 

Filter Controls: Filter Length (1-16) 

Frame Control: Choose frame to plot 

Auto Load Test: Toggle button to set analysis to automatically plot 

latest data 
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Lock T Interval: Toggle button to allow the selected time interval 

of the data to be automatically shown for each new test 

Burst Window 

Channel to plot:  Length In, Length Out, Force In, Force Out, Aux 1, Aux 2 

Units:    [V, mV, bits, mm] 

File Control:   Save As, File Name, Close 

Scope Window     

File:    Open log file, Close 

Edit:    Show Controls, Cursor Readout, Colour 

Time Base:   Length of time for data displayed on the plot 

Channel (1 or 2):  Select channel to sample [Lin, Lout, Fin, Fout, Aux1, Aux2, SL] 

Units:    Length (L) [um, mm, Lo, Lf, V] 

    Force (F) [mN, N. gm, kg, Fmax, V, Pa, kPa, MPa] 

    Sarcomere Length (SL) [um, SLo] 

V Scale:   Select a scale for the vertical axis [Auto, Fixed] 

Help     

600A Help:    Opens a .pdf version of this manual on-screen 

About:   Shows information about the program including version number of 

 the software and the real time A/D driver (RTAD) 
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3.0 Quick Start Guide 

 This quick guide will help you get your system up and running in as little time as 

possible, including both setup and explanation of basic software features. 

3.1 Instrument Setup 

 The 600A Controller PC has a compact tower case that can be oriented to stand as a 

tower or to lay on its side depending on the available space.  Placement of the computer should 

take into account the following criteria. 

 Adequate ventilation for cooling.  

 Protection from water, dust, dirt, vibration, and shock. 

 Within a maximum of 2m (6 ft.) from the force transducer and length controller 

electronics to allow for connection. 

 

A keyboard and mouse are supplied with the PC.  Plug each into an available USB port 

on the back panel of the PC.   

 

We suggest using a wide screen LCD monitor for maximum effectiveness. This may have 

been supplied by us or you can use any other modern-day monitor designed for use with a PC. 

The screen resolution is automatically set to the maximum available resolution of the monitor 

when the PC boots up.   

 

In order for the PC to properly recognize the monitor you must ensure that the monitor is 

switched on before booting the PC.   

 

Connect the monitor to a video port on the back panel of the PC (VGA, DVI, or HDMI). 

Plug the supplied AC power cord into the back of the PC and into an appropriate AC outlet.   

 

 

The 600A is shipped completely configured; you do not need to install any 

software.  The 600A PC runs under a real-time version of the Linux operating 

system and therefore you should not attempt to load Windows or Mac software on 

the 600A.   

 

 

The 600A is a high performance data acquisition system that provides capabilities 

not normally found in PC programs.  For this reason it is important that you do 

not change the BIOS settings on the PC or make significant changes to the 

operation of the window manager.  Changes to BIOS settings and window 

manager settings can cause program malfunctions.  

 

If you want to network the PC an Ethernet port is available on the back of the PC.  The 

network is set for a DHCP server and therefore the PC will look for this server to obtain an IP 

address.  Please contact Aurora Scientific Inc. (ASI) if you have any questions about the setup of 

the PC including the network setup. 
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See the 604A A/D Signal Interface Manual for instructions on connecting your length 

controller and force transducer (or a dual-mode lever system) and stimulator to the A/D Signal 

Interface.  The 600A Digital Controller comes with all cables required to make these 

connections.  The 604A manual also provides instructions on connecting the ribbon cable 

between the back of the 604A Interface and the data acquisition card located in the PC.   

 

 

Take reasonable care to route the ribbon cable and the BNC signal cables away from AC 

power cords in order to minimize unwanted electrical noise from getting into your data. 

 

 

New 600A Controller PCs come with a 604A A/D Signal Interface but older models came 

with a 604C. These products are equivalent in operation and the model number is 

dependent on the data acquisition card installed in the PC. Any time this manual refers to 

604A it also applies to the 604C. 

 

3.2 Software Registration and Activation  

 

The ASI600A program must be licensed before it will run on your new PC.   

 

 

The following procedure will license your software and it can be completed in about 5 minutes.   

 

You will need: 

 600A PC with the ASI software to be activated 

 PC with an internet connection (does not have to be the 600A) 

 Product Key found on the serial number tag for the software. 

 

1. Click on the Activate Software icon located on the desktop. 

2. When the Activate window opens follow the on-screen directions as shown in Figure 1 

(remember Linux is case sensitive).  The first step will be to enter the Product Key which is 

a 5 character key with the format of three numbers followed by a letter and then a final 

number, e.g., 017A5.  Ensure you enter the Product Key and not the serial number.   
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Figure 1 ASI Activate Window 

3. After pressing the Enter key the ASI Activate program will provide you with an Activation 

Code which is an alpha-numeric character string consisting of three groups of 5 characters 

each separated by dashes, e.g., 7P101-70050-170A3.  

4. On the PC with internet access, point your web browser to: 

http://www.AuroraScientific.com/activate 

5. Enter the Activation Code returned by the ASIActivate program, your contact details and 

then click on the Activate! button.  See Figure 2. 

http://www.aurorascientific.com/activate
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Figure 2 ASI Product Activation Website 

6. Copy or write down the license code returned by the webpage.   

7. Enter the license code, and then enter the root user’s password (By default this password is 

set to “root”. If you have changed it, enter your new one.) 

8. Click on the desktop icon to start the 600A program to test that the license was installed 

correctly.   

9. Repeat as required for additional ASI software.  For example, if you have a PC with both 

600A and HVSL software, you must complete this procedure twice. 

 

Should you encounter any issues with this procedure, please contact ASI by phone or email, and 

we will be happy to help you with this process. 
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3.3 Verification of Correct Operation in Force Mode  

 

The ASI600A program requires that the force transducer and length controller 

signals have the correct polarity and that the two devices are connected correctly.  

If the signal polarity is reversed or the devices are not connected correctly 

then the force feedback will not work properly which could result in damage 

to the force transducer and length controller. 
 

  The system assumes that tension on the force transducer will result in a positive output 

voltage.  The program also assumes that a positive control signal to the length controller will 

produce a positive output voltage and that the resulting motion results in the muscle tissue being 

lengthened.  It is strongly suggested that you initially check out the operation of the system using 

a short length of rubber (elastic) band in place of the muscle tissue.  All ASI high speed length 

controllers have internal jumpers that allow the operation of the length controller to be reversed.  

If you have purchased your 600A along with a length controller and apparatus then the jumpers 

will have been set correctly at the factory. 

 

If an Aurora Scientific Inc. series 400A force transducer is used then the transducer Force 

Out connector can be connected directly to the 604A Force In connector.  If using another 

manufacturer’s transducer then the polarity of the transducer output signal must be determined 

prior to connecting the transducer.  The 600A assumes a force signal level ranging from –10 

volts to +10 volts.  It also assumes that the force transducer output increases with increasing 

tensile force (this is the standard for series 400A force transducers).  If the force transducer 

signal polarity is reversed (output decreases with increasing tension or negative output voltage 

for tension) then jumpers located within the 604A interface must to be changed.  Open the 604A 

interface by first removing the two Philips head screws located at the top edge of the box on the 

back panel.  Once the screws are removed simply slide the cover backwards and remove it.  You 

will now see two sets of jumpers located near the Length In and Force In BNC connectors.  

Remove the jumpers, rotate each of them 90⁰ and then reattach them.  This reverses the force 

input connections.  Likewise if the length controller produces a negative output voltage for a 

positive input voltage you can reverse the Length In signal with the jumpers provided. 

 

 

Older 604A and 604C Signal interfaces used slide switches instead of jumpers.  On these 

units slide the switch from one position to the opposite position in order to reverse the 

input signals.   

 

3.4 Linux and Desktop Overview  

 Once all components of the system have been connected together then turn on the 

monitor and then the PC.  The PC should go through the normal power on self-tests and then the 

Linux operating system should be loaded.  Once loaded, a Windows-like desktop should appear 

with a task bar at the bottom of the screen and several icons located on the desktop.  The desktop 

is shown in Figure 3.  The most frequently used icons will be ASI Log, ASI600A, Home, and 

data. The taskbar at the bottom of the screen shows the current windows that are open and 
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provides a simple method of switching between the windows.  Simply click on the taskbar item 

that you want to switch to and that window will become the current and top one.  The most 

frequently used icon at the bottom of the screen is the K icon at the far left of the screen.  The K 

icon is similar to the Start button in Windows.  It provides access to programs and also allows 

you to shut down the computer properly.  Just like Windows, Linux must be shut down properly 

since the file system is updated during the shutdown procedure.   

 

 For specific actions, like licensing software, you may need to obtain superuser privileges.  

This is done by clicking on the xterm icon on the desktop and typing the following: 
su 

Password:  root 

 

If you change the root password (superuser password) there is no way for ASI to recover 

the password if you forget or lose it.  Therefore please record the superuser password and 

store it in a safe place.   

 

 

Many users will elect to connect the ASI600A to a network.  Because the 600A is 

shipped with no login password and the root password is not secure. We strongly 

suggest that you set a secure password before connecting the 600A to a 

network. A secure password should not be a recognizable word, it should be a 

minimum of 6 characters containing letters (both upper and lower case), numbers 

and at least one special character (&, ^, $, #, @, !).  See Appendix E – Network 

Security for instructions on changing passwords and network setup. 

 
Figure 3 ASI600A Desktop 
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A brief description of the main icons on the desktop is provided below. 

Activate Software  

 Used to start the software activation program.  You must activate ASI software before it 

can be used.  See Section 3.2 Software Registration and Activation of this manual for 

instructions or refer to the Activation Instructions pdf file located on the Desktop.  

ASI Log   

Used to start the ASI Log program which creates a running log of the operation of the 

600A program as well as allowing the user to enter any comments pertinent to the experiment.  

All comments are time stamped and stored in a daily log file.  Starting with version 3.000 of 

600A this program is automatically started when 600A starts. 

ASI600A   

Used to start the ASI600A program in four channel mode where the A/D channels 

collected will be Length In and Force In, Aux1 and Aux2. 

installer  

Used to install a new version of the ASI600A software.  

xterm  

 Used to open an xterm.  An xterm can be used to type commands to the Linux system and 

is similar to the Windows CMD command that opens a command window.  An xterm must be 

opened in order to log on as superuser (su).  Later in the manual you will note times when you 

are required to open an xterm and log on as superuser in order to perform program upgrades, 

system maintenance, change passwords, etc.  

Home  

 Used to open the ASI600A home directory.  This is similar to Windows Explorer looking 

at the C:\ drive.  

data  

 Used to open the ASI600A data directory.  This is similar to Windows Explorer.  

ASI Website  

 This icon opens a web browser at Aurora Scientifics’ home page on the Internet.  Note: 

the 600A PC must be connected via the Ethernet port to an Internet connection for this link to 

work correctly.   

Trash 

 Used to delete files.  This is similar to Windows Recycle Bin.  To use simply drag files 

on top of the Trash can or select a file, right click and delete. 
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Like other modern operating systems Linux must be properly shut down when 

you are finished working with it. Failure to shut down the 600A PC correctly 

can result in program or data corruption and loss. To shut down the PC click 

the “K” Icon located in the bottom left corner of the Desktop. This opens the 

Windows equivalent of the “Start” menu. From here you can click on the Leave 

icon and then click Shutdown. The PC will then shut down safely and power itself 

off when done.  The shutdown icon is shown in Figure 4. 

 

  
Figure 4 K Menu Showing Shutdown Controls 

 

3.5 Starting the ASI600A Program 

To start the ASI600A program click on the icon labeled ASI600A.  When the program 

starts a window will open and you will be on the main page of the program. The main window 

provides access to all of the menu items and also contains a large graphing area for the display of 

data taken during a test.  The main window is displayed in Figure 5. 
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Figure 5 ASI600A Main Window 

A menu bar is located along the top of the screen which opens a drop-down menu for 

each heading.  A detailed description of each command is provided in the next chapter.  At the 

bottom of the Main window is a box that displays program status messages.  

 

Located near the bottom of the main window are Start Sequence, Start Test, Next Test, 

Stop Test and Zero Lout buttons.  These buttons are used to start a sequence of test protocols, 

start a single protocol, advance to the next test in a sequence, stop a test protocol, and zero the 

length command output to the length controller.   

 

The left side contains several text boxes that display the current values of an Elapsed 

Time timer, a Last Stimulus timer, digital readouts of the current Length In and Force In signals 

as well as the current Frame number and the start time of the current Frame.  The units for Lin 

and Fin are set using the Edit→ Display Settings menu.   

 

Also located on the left side of the window are Simulate and Auto Save buttons.  When 

the Simulate button is pressed the currently defined protocol will be plotted in the graph area of 

the main window when the Start Test button is pressed.   

 

When the Simulate button is pressed test protocols will not execute, instead the current test 

protocol will be shown on the main graph area. 

 

When the Auto Save button is pressed data will automatically be saved after a test 

completes.   

 

Data is automatically saved when running sequences and therefore the state of the Auto 

Save button doesn’t matter when running sequences.  
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3.6 Using the ASI600A Program – Quick Start Guide 

Now that that program is up and running we will go through the main steps required to 

set up an experiment, control a lever system (length controller) and take data.  For this example 

we will assume that the user has a 315C high-speed length controller and a 403A force 

transducer.  If your instruments are different then substitute your actual model number in the 

instructions.   

 

If you are connecting the 600A Digital Controller to a dual-mode lever system (a lever 

system that controls both length and force) then you will not have an external force 

transducer and you must select the None option under the force transducer model in 

Calibrate→ Models Attached.  When connected to a dual-mode lever system the program 

controls force using the Force Out connector on the 604A.   

 

When connected to a high-speed length controller and an external force transducer the 

program controls force by measuring the current force and then changing the length to obtain the 

desired force (force feedback).  The force control mode used by the 600A program is determined 

during program setup (see steps 1 through 4 below).  Ensure that you select the correct models.  

Also ensure that your lever system and force transducer are connected correctly to the 604A 

Signal Interface (see the Instruction Manual for the 604A for connection instructions).   If you 

are electrically stimulating the muscle tissue then ensure that the stimulator is also connected 

correctly.   

 

It is recommended that while you are becoming familiar with the program you use an 

elastic (rubber) band connected between the lever arm and the force transducer instead of 

using muscle tissue.   

 

Use the following procedure to get the program up and running and to perform your first 

tests.  Once you have completed this Quick Start Guide you will be familiar with the operation of 

the program. More details about using the program are provided in chapters 4 through 7 of this 

manual.  

 

1. Turn on the PC, log in, and start the ASI600A program (Section 3.4 Linux and Desktop 

Overview).  Set the size of the main window. 

2. Turn on the length controller and force transducer electronics.  Attach either muscle 

tissue or an elastic (rubber) band between the lever arm and the force transducer. 

3. Click on the Calibrate Menu heading. 

4. Select Models Attached and the display should be as shown in Figure 6.  Click the button 

next to 315C and the button next to 403A (substitute your model numbers if different).  

This sets the default calibration values for length and force to the settings that correspond 

to the selected instruments.  If you are using instruments that are not listed on the Models 

Attached screen then make sure you perform the Length and Force calibrations before 

proceeding to step 5. If you are using a dual-mode lever system (measures and controls 

both length and force) select the model number under Lever Systems and then select 

“None” under Force Transducer.  Exit the Models Attached screen by clicking on OK. 
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It is a best practice that you perform a proper calibration of your length controller and 

force transducer.  For the purposes of this quick start guide you can use the default 

calibration values for now.  

 

 
Figure 6 ASI600A Models Attached Window 

5. Click on the Setup Menu heading and then click on Open.  The Setup window will open 

and should appear as in Figure 8.  You will note the Setup window is divided into five 

sections, Set Reference Length, Fiber Cross Section, Other Parameters, Set Zero Load 

and Notes.   

6. In the Set Reference Length section press the Zero Lout button and then enter the current 

muscle tissue length in the Reference Length text box.  Now press the Record Lin button.  

After pressing the Record Lin button the program will sample the current Length In value 

and display this value, in mV, in the Lin – Length In text box.  At the same time the 

program will display the reference length in the Lref – Ref. Length text box. 

 

We refer to the muscle tissue length when Lout is set to zero as the reference length (Lref).  

Lref must be set correctly or the control system will not operate as desired.  There are two 

distinct steps required to set Lref correctly, i) measure the actual length of the preparation 

and record this length in the box to the right of Reference Length, ii) press the Record Lin 

button to tell the program to associate the current Lin signal with the Reference Length 

you set.  What you are doing in this step is giving the computer a datum from which all 

length movements and measurements will be based.   
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After setting the reference length do not adjust the Zero Offset potentiometer 

control on the front of the length controller or the X stage controls that affect the 

overall tissue length.  If you do you will create a length offset between the actual 

position and the position that the computer reports.  This offset can result in 

incorrect data being recorded and the system not controlling to the desired length, 

force or sarcomere length.  If you change the Length Offset potentiometer on 

the Length Controller or the X stage position then you must perform step 6 

again. 

 
Figure 7 ASI600A Setup Window 

7. The lower half of the Set Reference Length section allows you to enter the initial length 

(Lo) and the fiber length (Lf). You have the option of manually entering Lo and Lf or 

having the program set them automatically.  Click on the Lo=Lref button to set Lo equal 

to Lref.  Lo is used for plotting length in terms of L/Lo but it is also used in test protocols 

for controlling length.  If you want to work in units of fiber lengths then either enter the 

fiber length (Lf) or click on the Lf=Lo button to set them equal. 

 

In most cases Lo is equal to Lref.  

 

 

 

Do not set Lo to zero. Unexpected operation of the length controller can result 

from improperly setting the Lo value.  Lo must always be set to a positive, non-

zero value (the initial length of your tissue).  This value is used in length control 
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functions and therefore if it is set incorrectly unexpected movement can occur. 

8. In the Fiber Cross Section area of the Setup window the fiber cross section is set by first 

choosing the type of cross section: circular, rectangular or elliptical and then entering the 

dimensions corresponding to the type of cross section you selected.  The program will 

automatically calculate the Effective Diameter (Do).  Do is the diameter of a circular 

cross section that has the same cross sectional area as the tissue. 

 
Figure 8 ASI600A Setup Window 

9. The Other Parameters section can be skipped for now or you can set the initial sarcomere 

length (SLo) if desired and the maximum tension the muscle can develop (Fmax). 

 

 

SLo and Fmax are used for plotting normalized sarcomere length and force 

(SL/SLo and F/Fmax).  Both SLo and Fmax can also be used in protocol control 

functions. For this reason it is important that these parameters be positive and 

non-zero. If SLo and Fmax are not known then enter 1.0 for each of these 

parameters, do not set either of them to zero. 

 

10. Near the bottom of the Setup window is the Set Zero Load section.  Set the muscle to the 

desired baseline force and then press the Record Fin button.  This will record the current 

force and display this value, in mV, in the Fin – Force in text box.  As the user you can 

choose what to use as the zero force, options include but are not limited to:  
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a. Force before attaching the muscle tissue to the force transducer with the force 

transducer hook in air. 

b. Force before attaching the muscle tissue to the force transducer with the force 

transducer hook in liquid. 

c. Force with the tissue attached to the hook but with the muscle slack.  

d. Force with the muscle set to Lo. 

e. Force with SL set to a particular value. 

f. Regardless of which option you choose after pressing the Record Fin button you 

will note that the force is set to 0 mN.  The Set Zero Load function is similar to 

Set Reference Length in that it provides a datum to the computer for force control 

and reporting.  

11. The last section is the Notes section at the bottom of the window.  If desired enter 

comments in the Notes section and these comments will be stored in all data files.   

12. Either leave the Setup window open or close it using the X control in the top right corner. 

13. The next step is to create a test protocol.  Select Protocol→ Open to open the Protocol 

editor. 

14. The protocol editor allows the user to create a series of control events based on time.  The 

protocol window is a standalone window that can remain open during testing.  This 

allows for easier viewing of the currently defined protocol and allows the user to quickly 

and easily modify the protocol and then run it.  The Protocol Window features three sub 

menus called Protocol, Stimulus and Sequencer.  Click on the headings at the top of the 

window to switch between these windows. 

 

There are four main headings associated with creating a protocol (see  

Figure 9) these are:  

 

Step     Time     Function     Parameters 

 

A test protocol consists of at least three steps but it can have many more.  Each step has a 

start time (Time), a function and parameters (if required by the particular function 

chosen).   

 

At the top of the protocol window are text boxes showing the current protocol file name, 

the current Lo value and the current Fmax value.  None of these text boxes can be 

modified as the contents of the boxes come from other parts of the program.  Below the 

text boxes is an area showing the contents of the protocol file and below this are control 

buttons and text entry boxes located near the centre of the screen.  Lmin and Lmax are 

also set on the protocol window and will be discussed in steps 18 and 19 below.  At the 

bottom of the screen are: Sampling Rate, Comment text box and control buttons that start 

a test (Start Test), load a protocol (Load), save a protocol to a new file name (Save As), 

and save the current protocol to the currently defined name (Save). 
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Figure 9 Protocol Editor Screen  

15. For this example we will create a simple tetanus stimulation protocol that controls the 

stimulator and collects data.  The protocol will start data collection, issue a stimulation 

timing pattern and then disable data collection.  Enter the protocol shown in Table 1 

below or Press Load and load the protocol file Tetanus.pro. 

 

Table 1 Example Test Protocol – Tetanus.pro 

 

 

 

 

 

16. As you enter the protocol you will note that the Step number is automatically completed 

for you.  Also note the help text that is displayed in the box near the bottom of the screen.  

This test box provides a brief description of each function including the expected number 

of parameters, the valid units and an example of the function’s use.  A very important 

note about protocols is that you must ensure that Time increases for each successive step.  

The program will parse the protocol before saving it and if the times don’t increase an 

error will be generated.  If the number of parameters entered for a function or the units 

are incorrect then the step will not update when the Enter key is pressed.  Error and status 

messages are printed in the text box at the bottom of the screen.  There are several 

possible units that can be used for functions that include length, force or time.  The units 

of length are: um, mm, Lo, Lf and volts.  The units of force are: mN, N, gm, kg, Pa, kPa, 

Fmax and volts.  The units of time are: ms and s.  Parameters are also case sensitive so 

take care to enter units correctly.  Test protocols can be of any length and can contain 

multiple occurrences of the same function if desired. 

 

Functions can’t start exactly at the end time of a previous function there must be 

at least 0.1 ms between the end of one function and the start of the next. For 

example: if a Length-Ramp starts at 100.0 ms and has ramp duration of 50.0 ms 

Step Time (ms) Function Parameters 

1 0.0 Data-Enable  

2 500.0 Stimulus  1  0 ms 

3 4000.0 Data-Disable  

4 4000.1 Stop  
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the next function cannot start until 150.1 ms. (100.0 + 50.0 + 0.1).  Failure to 

respect the timing in a protocol can cause the program to perform unexpected 

operations and in some cases the PC can “lock-up”. 

 

 

All protocols must include at least one Data-Enable and one Data-Disable 

command. 

 

17. Stimulus is a special function in that the parameters are a stimulus profile number and a 

delay time (the delay controls the actual time that the first pulse of the stimulation is 

produced, the actual time of stimulation is the Time associated with the Stimulus 

command plus the delay time). The stimulus profiles are defined by clicking on the 

Stimulus tab at the top of the Protocol window.  Up to 10 stimulus profiles can be 

defined. 

 

 

Stimulation can continue after a test protocol is finished! If the Train Duration 

specified in the stimulation profile is greater than the protocol’s test duration then 

stimulation will continue to be active after the protocol completes.  Please see 

Section 4.6.2 Stimulus for further details on stimulation control.   

 

18. Enter Lmin; this controls the minimum length that the program can command the lever 

system to move to.  The Lmin value is set as a percentage of Lo, a typical value might be 

0.10 which corresponds to a minimum length of 10% of Lo.  This control is used to limit 

the movement of the lever to ensure that the muscle is not shortened beyond a safe limit.   

 

 

Make sure that Lmin is set to a realistic number.  If it is set incorrectly the 

program may not function as expected. 

 

Lmax and Lmin take priority over all control commands.  If you tell the system to go to a 

length outside of the Lmax/Lmin range the program will clamp the length at the limits 

specified by Lmax and Lmin. The available range of Lmin is -10Lo to +10Lo. In all cases Lmin 

must be less than Lmax. 

 

Enter Lmax; this controls the maximum length that the program can command the lever system 

to move to.  The Lmax value is set as a percentage of Lo, a typical value might be 1.25 which 

corresponds to a maximum length of 125% of Lo.  This control is used to limit the movement of 

the lever to ensure that the muscle is not stretched beyond a safe length.  

 

 

Make sure that Lmax is set to a realistic number.  If it is set incorrectly the 

program may not function as expected. 

 

Lmax and Lmin take priority over all control commands.  If you tell the system to go to a 

length outside of the Lmax/Lmin range the program will clamp the length at the limits 

specified by Lmax and Lmin. The available range of Lmin is -10Lo to +10Lo. In all 

cases Lmax must be greater than Lmin. 
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19. When you have finished entering the protocol you must save it before you can start a test.  

Either press Save As to save the protocol file to a new file name or simply press Save to 

overwrite the existing protocol file.  The program will not run a protocol that hasn’t been 

saved.  

20. The Stimulation profiles should be entered before executing a protocol which includes 

stimulus or trigger commands. Click on the Stimulation tab at the top of the Protocol 

window to switch the display to the Stimulation setup window, see Figure 10. 

 
Figure 10 Stimulus Window 

Continuing with the tetanus example, a typical stimulus profile would be as shown in Table 2 

Stimulus Profile 1.  In this stimulus profile the Pulse Width is 1 millisecond (ms), the Pulse 

Frequency is 100 Hz and the Frequency Duration is 1000 ms.  Since this stimulation pattern is 

intended to occur only once the Train Frequency has been set to 0.1 Hz and the Train Duration to 

0 sec. 

 

 

Stimulus profiles are stored along with the protocol in the protocol file.  Make 

sure you resave the protocol after changing stimulus profiles.  Failure to resave 

the protocol file could result in unexpected operation. 

 

Table 2 Stimulus Profile 1 

Pulse 

Width 

(ms) 

Pulse 

Frequency 

(Hz) 

Frequency 

Duration 

(ms) 

Train 

Frequency 

(Hz) 

Train 

Duration 

(s) 

1.0 100.0 1000.0 0.100 0.000 
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21. On the main window press the Simulate button and then press Start Test to review the 

protocol that you just entered and saved.  If you are satisfied with the protocol and there 

are no errors then you can turn off the Simulate button on the main screen in preparation 

for running the test.   

22. Before running the protocol you may want to start Scope.  Scope provides a real-time 

scrolling output on a separate window that resembles an oscilloscope or a strip-chart 

recorder.  Scope is very useful at providing a long-term record of what length, force, 

sarcomere length and auxiliary data has done over a time period of up to 4 hours.  The 

main screen provides a numerical output of the current Lin and Fin.  This readout is 

useful to see what these values are at any given time but for slow trends (like monitoring 

the contraction of a skinned muscle fiber) it is very useful to have the Scope function.  

Click on Open on the Scope menu to open the Scope window.  Scope runs independently 

of the main control and graphics section of the program and because we are using a real-

time version of Linux there is no concern that Scope will interfere with the main control 

program.  Scope runs at a constant 100 Hz. In addition to buffering up to 4 hours of data 

Scope can also be used to record data at low sample rates (1 to 100 samples per second).  

See Section 7.0 Scope for a more detailed description of Scope. 

23. Press the Start Test button on either the bottom of the Protocol window or the bottom of 

the Main window to execute the protocol.  The protocol will start as soon as you press the 

button and the results will start to appear on the Main window as soon as the protocol 

starts.  If the protocol includes a Repeat function then the results of each execution of the 

protocol will be plotted as soon they occur.  The graph for each repetition is defined as a 

Frame and there is a button near the bottom of the main screen that allows the user to 

scroll through the Frames.  If the protocol has more than one pair of Data-Enable and 

Data-Disable functions then each Data-Enable function will also generate a new Frame. 

24.  Once the protocol is complete the data can be saved by clicking on File→ Save Data. 

Alternatively you can automatically save the data at the end of each test by pressing the 

Auto Save button on the Main window. 

25. Analysis can be used to review the stored data, zoom in on a selected area and perform 

calculations.  To open the Analysis window click on Analysis→ Open.  See Section 6.0 

Analysis for more details on using Analysis. 

26. The ASI600A program can be closed either by clicking on Exit under the File menu or by 

clicking on the X in the upper right corner of the Main screen window. 



INSTRUCTION MANUAL PAGE 30 OF 114 
MODEL 600A 

DIGITAL CONTROLLER  VER. 3.000 

  

 

  

File: 600A.v3.000.Manual.docx    Aurora Scientific Inc., 2003-2012 

4.0 Main Program 

 The ASI600A Digital Controller program uses a familiar Windows-type interface that 

consists of a Main window containing a graphics window, control buttons, several text readouts 

and a series of drop-down menus.  The Main window can be moved, re-sized, minimized, 

maximized and closed by clicking on the various window controls provided.  In the upper right 

corner of the window are minimize, maximize and close buttons.  Clicking anywhere on the 

window will bring the focus to the window.  The window can be dynamically re-sized by 

clicking on a border or a corner of the window.  Most of these controls are similar to those found 

on Windows or Apple operating systems.  Details of the Main program window and program 

operation will be presented in the following sections. 

4.1 Main Screen 

 The main screen consists of a menu bar at the top, a large graphics window located in the 

centre, text readouts and control buttons located on the left border, control buttons below the 

graphics window and a status line at the bottom of the window (see Figure 11). 

4.1.1 Graphics Area of Main Window 

 The graphics area of the Main window can be configured by the user to show the data 

channels of interest.  Configuration of the graphics area is done using the Edit→ Display Settings 

window.  Using the Display Settings window the user can select to plot up to four different data 

channels, choose the location of each channel in the graphics area, set the size of the plot relative 

to the others, and also set the units and colour for the data on each channel. The available data 

channels include: Length In, Force In, SL, Aux 1, Aux 2 and Stimulus.  Each graph consists of 

time along the x-axis versus the chosen data channel on the y-axis.  The relative size of each 

channel’s graph can also be set through the Display Settings window.  The Main window’s 

graphics area is updated in real time as the data is being collected.  The graphics area is also 

updated whenever the user makes changes through the Display Settings window. Please see 

Section 4.3.1 Display Settings for further details on the window.   

4.1.2 Control Buttons 

 The main screen includes five control buttons located beneath the graphics window.  

These buttons are: Start Sequence, Start Test, Next Test, Stop Test and Zero Lout (see Figure 11 

ASI600A Main Screen).  

Start Sequence 

The Start Sequence button is used to start a sequence of test protocols.  The Reference 

Length must be set using Setup→ Open before the Start Sequence button will operate.  Upon 

clicking the Start Sequence button the program will execute the first enabled protocol in the 

sequence and then either wait for the Next Test button to be pushed to advance to the next 

protocol or automatically advance to the next protocol in the sequence depending on how the 

sequence timing is set.  Results of each protocol are plotted on the Main window as the protocol 

is executing.  The results will automatically be plotted on the Analysis window if the Auto Load 

Test button on the Analysis window is pressed.   
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Figure 11 ASI600A Main Screen 

Start Test 

The Start Test button is used to start a test protocol.  The Reference Length must be set 

using Setup  Open before the Start Test button will operate.  Upon clicking the Start button the 

program will execute the function listed for each step in the test protocol at the times specified in 

the protocol.  The data is plotted on the Main window as the protocol executes.  The results will 

automatically be plotted on the Analysis window if the Auto Load Test button on the Analysis 

window is pressed.   

Next Test 

The Next Test button is used to start the next protocol in a sequence.  The Next Test 

button will only become active after a sequence of two or more protocols has completed the first 

protocol in the sequence and the timing in the sequence is set to wait for user input. The status 

line will show the current protocol in the sequence and the total number of protocols to be 

executed.  If the timing in the sequence is set to automatically advance to the next protocol then 

there is no need to press the Next Test button. 

 

If automatic timing is selected and the timer is counting down to the start of the next 

protocol in a sequence, then the user can bypass the delay time by pressing the Next Test 

button.  When Next Test is pressed the countdown timer will be set to zero and the next 

protocol in the sequence will start immediately. 

Stop Test 

The Stop Test button is used to stop a test protocol or a sequence of test protocols.  The 

button freezes all control action of the program as soon as the button in pressed.  If the length out 

is set to 150 microns when the Stop Test button is pressed then it will stay at this level.  The 
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graph presented on the Main screen will show the data collected from all channels up to the point 

at which the Stop Test button was pressed.  

Zero Lout 

 The Zero Lout button is used to zero the control output to the length controller.  The 

control output is labeled Length Out on the front of the 604A Signal Interface box.  There are 

several reasons for wanting to zero the Length Out signal.  Normally Length Out would be 

zeroed prior to attaching a muscle to the lever system.  This provides a known starting point for 

all tests.  Depending on the structure of any particular test protocol the protocol may end with 

Length Out at some non-zero value.  The user may want to re-zero the Length Out signal prior to 

starting another protocol. 

 

It is best practice to press the Zero Lout button after a protocol or sequence has been 

stopped using the Stop Test button.  This will ensure the length controller is set to a 

known location before continuing testing.  

 

4.1.3 Text Readouts 

 Six text readouts are located on the left side of the Main screen.  The first two readouts 

are timers that can be used to time experiments and to measure the time since the last 

stimulation.   Below the timers are two text readouts that show the current values of Length In 

(L) and Force In (F) in the units selected by Edit→ Display Settings.  These readouts provide a 

convenient way of monitoring the current status of the lever system, the force transducer and the 

600A controller.  Please note that Scope provides a graphical readout of these same values.  

Below L and F are two readouts showing the Frame number and Frame starting time in seconds. 

The Frame and Time readouts are used primarily if the test protocol includes a Repeat function.  

Each repetition of the protocol is defined as a frame and the Frame readout in conjunction with 

the up/down arrows allows the user to view the data from each repetition of the protocol.  The 

Time readout indicates the start time of the Frame currently being displayed.  Note: a frame is 

also created each time a Data-Enable command is processed in a protocol.   

 

 Also located on the left side panel are two control buttons listed under the Tests heading 

near the middle of the section.  The first button labeled Simulate is used to check the timing of a 

protocol.  If the Simulate button is pressed then when either the Start Test or the Start Sequence 

buttons are pressed the output control signals and the Stimulus and Triggers will be displayed in 

the Main window graphics area.  No control signals will be issued to the length controller.  The 

second button under the Tests heading is Auto Save and this is used to cause the program to 

automatically save the data after each Start Test button push.  Data is saved to sequentially 

named data files.  If the Auto Save button is not depressed then the user must manually save the 

data after the test finishes by using the File→ Save Data function. 

 

Data is automatically saved when sequences are run.  The format of the data file names are 

set on the sequence window. 
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4.1.4 Status Line 

 A status line is located at the bottom of the screen that provides information about 

program operation. 

4.2 File Menu 

The File menu contains commands to save data files and exit the program, see Figure 12. 

Save Data 

Opens a Save As dialog box that allows the current data to be saved to disk.  Note: the 

data file is stored in ASCII format and the structure of the file is provided in Appendix A - 

ASI600A File Structure. 

Exit 

Closes the ASI600A program. 

 

 
Figure 12 File Drop Down Menu 

4.3 Edit Menu  

The Edit menu contains two commands, Display Settings and Show Controls.  Both of 

these are used to change the appearance of the program. 

4.3.1 Display Settings 

The Display Settings window is split into two main regions, the top part of the window is 

labeled Signals & Sizes and it is used to select the signal to be plotted on each of the four graph 

locations and the relative vertical size of each graph, the bottom part is labeled Units & Colors 

and it is used to set the units and colours of the different signal types. 
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Units cannot be selected for Stim and Aux channels. Stimulus units are always defaulted 

to 0 or 1 (off or on).  Aux channel units can be set in Section 4.4.1 Models Attached.  

 

 The choices for each plot location are: Length, Force, SL, Aux1, Aux2, Stimulus and Off.   

 

Plot location 1 can’t be turned off as the user must always plot at least one data channel.  

Therefore Off doesn’t appear in the plot location 1 drop down menu for signal selection. 

 

The vertical sizes available are: 1, 2, 3, 4, 5 and 10.  The relative size of each plot is taken 

as a ratio of the size number for that particular plot location divided by the total size of all plot 

locations that are not set to off. 

 
Figure 13 Display Settings Window 

The display colour for each channel can be set by clicking the respective colour block 

found to the right of the signal units.  Beside the Length and Force signals are blocks that say in 

and out. These represent Length In, Length Out, Force In, and Force Out respectively. Below 

these are blocks with labels sl (sarcomere length), stm (stimulus), ax1 (Aux1), ax2 (Aux2). 

Clicking any of these blocks opens the colour selection window seen in Figure 14.  To set a 

colour, pick the desired colour or enter its numerical value and then click okay. 

 

At the bottom of the display settings window is a background colour option. This allows 

the user to pick a light background (black lines on a white background) or a dark background 

(green lines on a black background).  These two backgrounds provide for a greater degree of 

flexibility in plotting data.  It is often much easier to find colours that will display well on a dark 

background as oppose to a light background. 

 

The program automatically scales the display axes to the range of the collected data.  Plot 

manipulation, zooming, etc. is provided under the Analysis section of the program that is 

discussed in Section 6.0 Analysis.  
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. 

 
Figure 14 Select Signal Color Window 

 

4.3.2 Show Controls 

Click on Edit→ Show Controls to hide or show the controls on the left side of the main 

window.  Hiding the controls maximizes the area on the window for displaying test data, see 

Figure 15.   

 

  
Figure 15 Main Window with Controls Hidden 
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4.4 Calibrate Menu 

The Calibrate menu contains commands to set the models of lever system and force 

transducer that will be used with the 600A controller, to calibrate both length and force and to 

provide force and sarcomere length feedback control, see Figure 16. 

4.4.1 Models Attached 

The Models Attached menu item allows the user to set the model of lever system and 

force transducer that is connected to the 600A (see Figure 17).  If you are using an ASI 

instrument then check the appropriate model number and the length and force calibrations will be 

set to the factory specifications.  When selecting a dual-mode lever system (models: 300C, 

300C-LR, 305C, 305C-LR, 310C and 310C-LR) please ensure that you select none under the 

Force Transducer heading.  This will tell the program that you are using the force transducer 

built into the lever system and not an external transducer.  If you are using a length controller or 

force transducer built by a different manufacturer select the ASI model closest to your device 

and then perform a manual length and force calibration. 

 
Figure 16 Calibrate Drop down Menu 

The Models Attached screen also has an area where you can set the Name, Units, Scale 

factor and Offset for the two auxiliary input channels that are available. See Figure 17 for an 

example of auxiliary channels measuring temperature and Aux 2.  The Scale factor and Offset 

are selected to convert volts to the units you specified in Units.  Let’s assume that a temperature 

input is attached to Aux 1 with a signal of 10mV for every °C.  To calculate the Scale for this 

signal you would simply convert the 10 mV to read in volts (0.01V) and then invert the 0.01V/°C 

to obtain 100°C/volt, you then enter 100 in the Scale factor text entry box.  Often there will be a 

small offset present on the signal and this can be compensated for by entering, in the Offset text 

entry box, the difference between what the output reads in the 600A program and what you know 
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it to be.  In the example shown in Figure 17 you will note the offset is -1.10°C which 

compensates for the offset seen on this particular temperature sensor. 

 

 

 
Figure 17 Models Attached Window 

4.4.2 Length Calibration 

 The Calibrate→ Length menu item opens the Length Calibration window (see Figure 18). 

This window provides a simple means of calibrating the length channel input and output.  The 

calibration screen can be used to perform multipoint calibrations or you can simply enter a 

known calibration constant.  When doing multi-point calibrations the data and a linear curve fit 

are plotted when the calculate button is pressed at the end of the calibration.  The program 

calculates the calibration constants from the sampled data and displays the calculated values on 

the right side of the screen under Calibration Factors.     

                                                                                      

To calibrate a lever system you will require an independent means of measuring the 

length (or position change) of the lever arm.  At the start of calibration you will note that there is 

a Length In value next to the 0.00 value under the Length Out (v) column while all other boxes 

in the Length In (v) column are blank.  Upon entering the Length Calibration screen the program 

sets Length Out to 0.000 V and records Length In.  This value is then displayed in the Length In 

column.  Now set the Length Out voltages to your desired values or use the default values 

shown.  Use the up/down arrows to the right of the Length Out (v) column to set the length out 

voltage or simply type in the desired voltage in the text box.  Press the radio button to the left of 

the desired Length Out (v) setting which causes the system to measure the current length input.  

Manually measure the actual length and enter the actual length in the column labeled Length 
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(mm).  Repeat this procedure for up to five Length Out voltages.  Once complete press the 

Calculate button at the bottom of the screen.  The program will plot the calibration data, fit a 

curve to the data and then automatically calculate Length Out and Length In Scale factors and 

Offsets (see Figure 19). 

 

Alternatively, if you know the input and output scale factors and offsets you can enter 

them directly in the text boxes on the right side of the screen. 

 
Figure 18 Length Calibration Window 
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Figure 19 Length Calibration Window Showing Completed Calibration 

4.4.3 Force Calibration 

   The Calibrate → Force menu item opens the Force Calibration window (Figure 20). 

This window provides a simple means of calibrating the force. The calibration screen can be 

used to perform multipoint calibrations or you can simply enter a known calibration constant.  

When doing multi-point calibrations the data and a linear curve fit are plotted when the calculate 

button is pressed at the end of the calibration.  The program calculates the calibration constants 

from the sampled data and displays the calculated values on the right side of the screen under 

Calibration Factors.     

 

To calibrate the force transducer you will require a series of known masses that can be 

attached to the force transducer.  Start with no mass attached to the transducer and press the 

square radio button in the Rec column next to the 0.0 gm line.  Pressing the radio button causes 

the program to input the current Fin signal.  Now apply a series of known weights to the force 

transducer, enter the actual weight and press the corresponding radio button.  Repeat this 

procedure for up to five weights.  Once complete press the Calculate button at the bottom of the 

screen.  The program will automatically calculate the Force In Scale factor and the Offset.  If you 

are calibrating a dual-mode lever system then the Force Controller information will be un-grayed 

and a calibration of the control signals can also be performed.   

 

Alternatively, if you know the input scale factor and offset for your transducer you can 

enter them directly in the text boxes on the right side of the screen.  
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Figure 20 Force Calibration Window Showing Completed Calibration 

 

4.4.4 Force & SL Control 

 The Calibrate→ Force & SL Control menu item opens the Force & SL Control Window. 

Please refer to Section 5.0 Force and SL Control for information on this subject. This window is 

used to calibrate and tune the force control and sarcomere length feedback control functions of 

the 600A program (see Figure 21).   
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Figure 21 Force & SL Control Window 

4.5 Setup Menu  

Click on the Setup Menu heading and then click on Open and the Setup window will 

open as shown in the left window of Figure 22.  The Setup window is divided into five sections, 

Set Reference Length, Fiber Cross Section, Other Parameters, Set Zero Load and Notes.   

Set Reference Length 

The Reference Length is defined as the muscle tissue length when Lout is set to zero.  In 

most cases this will also be the initial length (Lo) of the tissue.  Setting the Reference Length 

provides the datum used by all subsequent length measurements and length movements.  

Reference Length must be set before any test protocols are run.  In order to correctly set the 

Reference Length the researcher must have an independent means for measuring the actual 

length (Reference Length) of the muscle.   

 

 

The Reference Length must be entered (in mm) before pressing the Record Lin 

button. This step must be performed correctly or the control system will not 

operate as desired.   

 

In order to Set Reference Length start by pressing the Zero Lout button.  Next measure 

the length of the tissue and enter this value in the Reference Length text box.  Now press the 

Record Lin button.  After pressing the Record Lin button the program will sample the current 

Length In value and display this value, in mV, in the Lin – Length In text box.  At the same time 

the program will display the reference length in the Lref – Ref. Length text box.   

 

 

After setting the reference length do not adjust the Zero Offset potentiometer 

control on the front of the length controller or the X stage controls that change the 

overall tissue length.  If you do you will create a length offset between the actual 
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position and the position that the computer reports.  This offset can result in 

incorrect data being recorded and the system not controlling to the desired length, 

force or sarcomere length.  If you change the Length Offset potentiometer on 

the Length Controller or the X stage position then you must set the Reference 

Length again. 
 

The lower half of the Set Reference Length section allows you to enter the initial length 

(Lo) and the fiber length (Lf).   You have the option of manually entering Lo and Lf or have the 

program set them automatically.  Click on the Lo=Lref button to set Lo equal to Lref.  Lo is used 

for plotting length in terms of L/Lo but it is also used in test protocols for controlling length.  Do 

not set Lo to zero.  If you want to work in units of fiber lengths then either enter the fiber length 

(Lf) or click on the Lf=Lo button to set them equal.   

 

 
Figure 22 ASI600A Setup Window Showing Different Cross Section Calculation 

Lo - Initial Length  

The Initial Length (Lo) is normally defined as the tissue length under specified 

physiological conditions such as the overall length of the tissue when the sarcomere length is set 

to the resting sarcomere distance, the overall length when the tissue is at some low resting 

tension or the overall length which produces maximum tetanic force when stimulated.  Lo is set 

in units of mm.  The program uses Lo in two key ways: (1) it is used to plot normalized length 

(strain) as a percentage of Initial Length, i.e., L/Lo; (2) it is used in length control functions in 

test protocols to allow length changes in terms of a percentage length change (0.9 Lo being a 

length change to 90% of the initial length).  The Initial Length can be entered in the text entry 

box or the button labeled Lo=Lref located to the right of the text entry box can be pressed which 

will automatically set Lo equal to the reference length (see Figure 22).   
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Lf - Fiber Length 

The Fiber Length (Lf) is normally determined by the researcher and can be entered in the 

text entry box.  For the case of whole muscle and fiber bundles Lf is less than Lo whereas for 

single fiber experiments Lf may be equal to Lo.  In the case where Lf is equal to Lo you can 

click the button labeled Lf=Lo located to the right of the text entry box which automatically sets 

Lf equal to Lo.  Note it is possible to have all three lengths equal where Lref = Lo = Lf.  Fiber 

Length is set in units of mm.  The program uses Lf for plotting normalized length (strain) as a 

percentage of the fiber length, i.e., L/Lf.     

Fiber Cross Section 

In the Fiber Cross Section area of the Setup window the fiber cross section is set by first 

choosing the type of cross section: circular, rectangular or elliptical and then entering the 

dimensions corresponding to the type of cross section you selected.  The program will 

automatically calculate the Effective Diameter (Do).  Do is the diameter of a circular cross 

section that has the same cross sectional area as the tissue.  See Figure 22 for examples of 

Circular and Elliptical cross section setup windows. 

Other Parameters 

The Other Parameters section is used to set muscle and control parameters for a particular 

set of experiments.  The muscle parameters include: initial sarcomere length (SLo) and 

maximum tension the muscle can develop (Fmax).    

 

 
Do not set either SLo or Fmax to zero, if these values aren’t known then enter 1.0. 

SLo - Initial Sarcomere Length 

The initial Sarcomere Length (SLo) is normally defined as the sarcomere length under 

specified physiological conditions such as the sarcomere length when the tissue is slack, the 

sarcomere length when the tissue is at some low resting tension, or the sarcomere length which 

produces maximum tetanic force when the tissue is stimulated.  SLo is set in units of microns 

(um).  The program uses SLo in two key ways: (1) it is used to plot normalized sarcomere length 

(strain) as a percentage of Initial Sarcomere Length, i.e., SL/SLo; (2) it is used in sarcomere 

length control functions in test protocols to allow sarcomere length changes in terms of a 

percentage length change (0.9 SLo being a sarcomere length change to 90% of the initial 

sarcomere length).  The Initial Sarcomere Length is entered in the text entry box next to the SLo 

– Sarcomere Length (um) text.   

Fmax – Max Tension 

The maximum tension (Fmax) is normally defined as the maximum tension that is 

measured during a tetanic contraction.  Fmax is set in units of milliNewtons (mN).  The program 

uses Fmax in two key ways: (1) it is used to plot normalized force as a percentage of maximum 

force, i.e., F/Fmax; (2) it is used in force control functions in test protocols to allow force 

changes in terms of a percentage force change (0.9 Fmax being a force change to 90% of the 

maximum force).  The maximum tension is entered in the text entry box next to the Fmax– Max 

Tension (mN) text.   
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Set Zero Load 

Near the bottom of the Setup window is the Set Zero Load section.  Ensure that the 

muscle is slack and then press the Record Fin button.  This will record the current force and 

display this value, in mV, in the Fin – Force in text box.  As the user you can choose what to use 

as the zero force, options include: force before attaching the muscle tissue to the force transducer 

with the force transducer hook in air, force before attaching the muscle tissue to the force 

transducer with the force transducer hook in liquid or, force with the tissue attached to the hook 

but with the muscle slack.  Regardless of which option you choose after pressing the Record Fin 

button you will note that the force is set to 0 mN.  The Set Zero Load function is similar to Set 

Reference Length in that it provides a datum to the computer for force control and reporting.  

 

 

Please note that if the Set Zero Load function is not used properly then undesirable 

control actions may result when performing force clamps.  An example of this 

would be the following.  Assume that the user sets the Zero Load when the muscle 

is at a resting tension of 2 mN.  A protocol is then created that includes a force step 

to 1 mN.  Since the program has been told that 2 mN is actually zero force the 

force command will actually result in the muscle being stretched (force increased 

from 0 to 1 mN according to the program) whereas in reality the force has 

increased from 2 to 3 mN.  The user wanted the force to decrease to 1 mN but due 

to the faulty use of Set Zero Load an actual force of 3 mN resulted even though the 

program reports the force as 1 mN. 

 

 

Ensure that the Force Offset control potentiometer on the front panel of the force 

transducer is not adjusted after setting the zero load.  If the control is changed then 

Set Zero Load should be executed again. 

 

Notes 

The last section is the Notes section at the bottom of the window.  If desired, enter 

comments in the Notes section and these comments will be stored in all data files.   

 4.6 Protocol Menu  

The Protocol menu item provides an Open and a Close command.  Opening the Protocol 

window provides access to the Protocol editor, Stimulus setup and the Sequencer windows.  The 

Protocol window allows the user to create and edit test protocols.  The Stimulus window is used 

to define stimulation and trigger profiles.  The Sequencer window is used to create, edit and save 

protocol sequences.   

4.6.1 Protocol Editor 

Allows the user to define and edit a test protocol (see Figure 23).  Test protocols are the 

heart of the control system and they provide all the functions necessary to generate any muscle 

physiology test protocol desired.  The Edit Protocol screen can be divided into the following four 

sections: a) the top portion of the screen displays the test protocol, b) the middle section allows 

the user to edit selected lines of the protocol as well as set the Lmin and Lmax values, c) a text 

section is below the editing section and it displays information about the selected function and d) 

at the bottom the Sampling Rate can be set, comments can be entered and buttons are provided to 
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start the protocol as well as load and save protocols.  A status line is provided at the very bottom 

of the window.  

 

All test protocols are created in order of steps.  Each step includes a start time, a function 

and function parameters.  A step cannot start before a previous step has completed.  The program 

checks the protocol to ensure that each step starts at a later time but the user should still take care 

to ensure that the function called on the current step completes before the start time of the next 

step.  The minimum time between instructions is set in the program to be 0.1 ms. Therefore when 

creating an instruction it must have a start time that is a minimum of 0.1 ms after the time when 

the previous command finished.  All functions start at the start time set except for Stimulus and 

Trigger functions which are special and can be delayed to start during a following command. 

 
Figure 23 Protocol Window 

Absolute vs. Relative Control 

 The 600A program can operate in either absolute or relative units of length and force.  

When operating in absolute mode the desired length, force or sarcomere length is set in the 

protocol function.  An example of absolute mode is the current length of the tissue is 9mm and 

the researcher wants to shorten the tissue to 8mm, an absolute function would simply specify the 

new length as 8mm.  The absolute mode can be thought of as change to the new value.  When 

operating in relative mode the researcher must think in terms of changes to the current value of 

length, force or sarcomere length.  An example of relative mode is the current length of the tissue 

is 9mm and the researcher wants to shorten the tissue by 1mm, a relative function would specify 

the new length as a change of -1mm.  The relative mode can be thought of as a change by the 
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given value.  The length, force and sarcomere functions listed below show examples of both 

absolute and relative modes. 

Absolute Control 

 The 600A program’s default setting is to make all control tasks absolute in nature.  This 

means that the program knows the current length of the preparation and when you request a 

length, force or SL change the program will take this request as an instruction to change to the 

new absolute unit.  The following is a simple example.  We will assume that the preparation is 

5.0 mm long and that Lref = Lo = 5.0 mm.  The test protocol calls for the tissue to be shortened 

by 1.0 mm to a new length of 4.0 mm.  The normal operation of the protocol functions are in 

absolute units so in order to create this shortening the protocol function would be  

 

Length-Step 4.0 mm   

 

Functions can also be structured in terms of fractions of a reference quantity; in this case the 

initial length (Lo) is 5.0 mm so a shortening to 80% of Lo (0.8 Lo) will also cause the tissue to 

shorten to 4 mm.  

 

  Length-Step 0.8 Lo 

Relative Control 

 Since the introduction of version 2.0, 600A has provided the capability to structure 

functions in relative units as well as the standard absolute units.  Many researchers have told us 

they prefer to structure protocols in relative terms such as a shortening by 20% as opposed to a 

shortening to 80%.  For this reason we enabled the use of relative units in control functions.  

Even though the program can now be operated in relative mode we feel that it is a best practice 

to set the datum for the program (Lref and zero force) correctly whenever a new preparation is 

attached as this provides maximum control options when using the program. 

 

Relative functions change the quantity by an amount not to an amount. All functions 

have the same structure whether being used in absolute or relative modes.  In order to cause a 

relative change simply add the prefix + or – to the quantity.  Using the example above, in order 

to shorten the preparation by 1.0 mm to a new length of 4.0 mm, the protocol function in relative 

mode would be  

 

Length-Step -1.0 mm   

 

Similarly the same shortening can be structured in terms of fractions of a reference quantity in 

relative mode so a shortening by 20% (-0.2 Lo) will also cause the tissue to shorten by 1mm.  

 

  Length-Step -0.2 Lo 

 

Functions 

 The protocol functions are organized into categories (See Figure 24). The following is a 

list of all available functions, a brief description of the function and a list of the required 

parameters and units that must be included with the function.  An example of the function’s 
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usage is included.  These examples are all shown as a time followed by the function name, 

parameters and units.   

 

 

                          Length            Force            SL                Stim           Control 

 
Figure 24 Protocol Dropdown Menus 

Length Functions 

Length-Step 

Description: Perform a step change in length. 

Parameters: 1, Absolute desired length [um, mm, Lo, Lf, volts] or Relative desired length 

[prefix quantity with + or -]  

e.g.: 1) Absolute: 20.0 Length-Step 105.0 um  (step change the length to 105 um) 

 2) Relative: 20.0 Length-Step +5.0 um   (stretch by 5 um) 

 

Length-Ramp 

Description: Perform a ramp change in length. 

Parameters: 2, Absolute desired length [um, mm, Lo, Lf, volts] or Relative desired length 

[prefix quantity with + or -], ramp time [ms, s] 

e.g.: 1) Absolute: 30.0 Length-Ramp 105.0 um 22.0 ms (ramp change length to 105 um over 

22 ms time) 

     2) Relative: 30.0 Length-Ramp -5.0 um 22.0 ms (ramp shorten by 5 um over 22 ms time) 

 

Length-Square 

Description: Change length using a square wave pattern. 

Parameters: 3, frequency [Hz], amplitude [um, mm, Lo, Lf, volts], duration [ms, s] 

e.g.: 20.0 Length-Square 55 Hz 0.2 mm 0.12 s 

 



INSTRUCTION MANUAL PAGE 48 OF 114 
MODEL 600A 

DIGITAL CONTROLLER  VER. 3.000 

  

 

  

File: 600A.v3.000.Manual.docx    Aurora Scientific Inc., 2003-2012 

Length-Sine 

Description: Change length using a sine wave pattern. 

Parameters: 3, frequency [Hz], amplitude [um, mm, Lo, Lf, volts], duration [ms, s] 

e.g.: 20.0 Length-Sine 55 Hz 0.2 mm 0.12 s 

 

Length-Sweep 

Description: Change length using a sweeping sine wave pattern. 

Parameters: 4, start frequency [Hz], end frequency [Hz], amplitude [um, mm, Lo, Lf, 

volts], duration [ms, s] 

e.g.: 20.0 Length-Sweep 10 Hz 100 Hz 0.2 mm 10 s 

 

Length-Sample 

Description Sample and store the length after a specified delay. 

Parameters: 2, sample number [1-9], delay time [ms, s] 

e.g.: 20.0 Length-Sample 3 50 ms  (measure length 50 ms after function start and store 

value in sample number 3) 

 

Length-Hold 

Description: Perform a step length change to the length value stored in the specified 

sample number.  

Parameters: 1, sample number [0-9]  (note: 0 corresponds to current length) 

e.g.: 20.0 Length-Hold 1   (hold length at value stored in sample number 1) 

 

Read-Larb 

Description: Read a file containing an arbitrary length waveform. 

Parameters: 3, filename, length-units [um, mm, Lo, Lf, volts], sampling interval [ms, s] 

e.g.: 20.0 Read-Larb pro/wave1.dat Lo 0.2 ms 

 

Write-Larb 

Description: Write an arbitrary length waveform to a file. 

Parameters: 3, filename, length-units [um, mm, Lo, Lf, volts], sampling interval [ms, s] 

e.g.: 20.0 Write-Larb pro/wave1.dat Lo 0.2 ms 

 

Send-Larb 

Description: Send a waveform (created by Read-Larb) to the real-time control module. 

Parameters: none 

e.g.: 20.0 Send-Larb 

 

Length-Arb (shown as Larb in the dropdown menu) 

Description: Output a length waveform (see Send-Larb) to the digital to analog converter 

(DAC). 

Parameters: none 

e.g.: 20.0 Length-Arb 
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Force Functions 

Force-Step 

Description: Perform a step change in force. 

Parameters: 1, Absolute desired force [mN, N, gm, kg, Fmax, Pa, kPa, volts] or Relative 

desired force [prefix quantity with + or -] 

e.g.: 1) Absolute: 20.0 Force-Step 25.0 mN (step change force to 25 mN) 

 2) Relative: 20.0 Force-Step +25.0 mN  (increase force by 25 mN) 

 

Force-Ramp 

Description: Perform a ramp change in force. 

Parameters: 2, desired force [mN, N, gm, kg, Fmax, Pa, kPa, volts], ramp time [ms, s] 

e.g.: 1) Absolute: 30.0 Force-Ramp 25.0 mN 22.0 ms (ramp change force to 25 mN over 

  22 ms time) 

 2) Relative: 30.0 Force-Ramp -5.0 mN 22.0 ms (ramp decrease force by 5 mN over 

        22 ms time) 

 

Force-Square 

Description: Change force using a square wave pattern. 

Parameters: 3, frequency [Hz], amplitude [mN, N, gm, kg, Fmax, Pa, kPa, volts], duration 

[ms, s] 

e.g.: 20.0 Force-Square 55 Hz 0.2 mN 0.12 s 

 

Force-Sine 

Description: Change force using a sine wave pattern. 

Parameters: 3, frequency [Hz], amplitude [mN, N, gm, kg, Fmax, Pa, kPa, volts], duration 

[ms, s] 

e.g.: 20.0 Force-Sine 55 Hz 0.2 kg 0.12 s 

 

Force-Sweep 

Description: Change force using a sweeping sine wave pattern. 

Parameters: 4, start frequency [Hz], end frequency [Hz], amplitude [mN, N, gm, kg, 

Fmax, Pa, kPa, volts], duration [ms, s] 

e.g.: 20.0 Force-Sweep 10 Hz 100 Hz 0.2 Fmax 10 s 

 

Force-Sample 

Description: Sample and store the current force after a specified delay. 

Parameters: 2, sample number [1-9], delay time [ms, s] 

e.g.: 20.0 Force-Sample 4 50 ms  (measure force 50 ms after function start and store 

value in sample number 4) 

 

Force-Hold 

Description: Perform a step change to the force recorded by Force-Sample. 

Parameters: 1, sample number [0-9] (note: 0 corresponds to current force) 

e.g.: 20.0 Force-Hold 4   (hold force at value stored in sample 4) 
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Force-Clamp 

Description: Monitor force and when it reaches a specified value then clamp the force for 

a specified time period. 

Parameters: 3, clamp force [mN, N, gm, kg, Fmax, Pa, kPa, volts], delay time [ms, s], 

duration [ms, s] 

e.g.: 20.0 Force-Clamp 28.0 mN 50 ms 1.0 s  (wait 50 ms then monitor force and when it 

reaches 28 mN hold the force for 1 s) 

 

SL Functions 

SL-Step 

Description: Perform a step change in sarcomere length. 

Parameters: 1, desired length in um 

e.g.: 20.0 SL-Step 2.3 

 

SL-Ramp 

Description: Perform a ramp change in sarcomere length. 

Parameters: 2, desired length in um, ramp time [ms, s] 

e.g.: 30.0 SL-Ramp 2.4 22.0 ms 

 

SL-Sample 

Description: Sample and store the current value of sarcomere length after a specified 

delay. 

Parameters: 2, sample number [1-9], delay time [ms, s] 

e.g.: 20.0 SL-Sample 6 50 ms (wait 50 ms then sample SL and store the value in sample number 

6) 

 

SL-Hold 

Description: Perform a step change to the sarcomere length recorded by SL-Sample. 

Parameters: 1, sample number [1-9] 

e.g.: 20.0 SL-Hold 6    (change SL to value stored in sample number 6) 

 

SL-Trigger 

Description: Send a trigger to VSL/HVSL to start recording. 

Parameters: 1, delay time [ms, s] 

e.g.: 20.0 SL-Trigger 5 ms   (wait 5 ms then trigger VSL/HVSL) 

 

SL-Track 
 Description: Turn ROI tracking in VSL on/off 

 Parameters: 1, on-off switch [0 –off, 1 –on] 

 e.g.: 100.0 SL-Track 1 (turn tracking on) 
 

Stim Functions 

Stimulus 

Description: Start issuing stimulation pulses. 

Parameters: 2, stimulus pattern number [valid range: 1-10], delay time [ms, s] 

e.g.: 20.0 Stimulus 1 5 ms   (Note: stimulation profile is defined in Protocol→ Stimulus) 
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Trigger1 

Description: Start issuing trigger pulses from port labeled Trigger Out 1. 

Parameters: 2, trigger pattern number [valid range: 1-10], delay time [ms, s] 

e.g.: 20.0 Trigger1 8 5 ms   (Note: trigger profile is defined in Protocol→ Stimulus) 

 

Trigger2 

Description: Start issuing trigger pulses from port labeled Trigger Out 2. 

Parameters: 2, trigger pattern number [valid range: 1-10], delay time [ms, s] 

e.g.: 50.0 Trigger2 9 15 ms    (Note: trigger profile is defined in Protocol→ Stimulus) 

 

Control Functions 

Data-Enable 

Description: Start data collection. 

Parameters: none 

e.g.: 0.0 Data-Enable 

 

Data-Disable 

Description: Stop data collection. 

Parameters: none 

e.g.: 100.0 Data-Disable 

 

Data-Burst 

 Description: Data collection at highest possible rate. 

 Parameters: 2, delay [ms, s], duration [ms, s] 

 e.g.: 100.0 Data-Burst 500 ms 200 ms (delay 500 ms, then turn burst on for 200 ms) 

Bath 

Description: Move ASI802D apparatus to desired bath. 

Parameters: 2, bath number [1-8], delay time [ms, s] 

e.g.: 20.0 Bath 3 2.0 s    (wait 2 seconds then change 802D to bath 3) 

 

Repeat 

Description: Repeat the entire protocol the desired number of times. 

Parameters: 1, number of repetitions [no units] 

e.g.: 1000.0 Repeat 5 

 

Stop 

Description: Ends the test protocol 

Parameters: none 

e.g.: 350.0 Stop 

 

Control Buttons on the Protocol Screen  

Insert  

Inserts a line in the protocol at the highlighted location.  The inserted line contains the 

same functions and parameters as in the highlighted line.   
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Append  

 Appends a line to the end of the protocol.   

 

Delete  

 Deletes the highlighted line in the protocol.   

 

Start Test  

Starts the currently loaded protocol executing.  This is the same button as the Start Test 

button on the main screen.   

Load 

Loads a protocol file saved on disk.  Once a protocol has been loaded it can be executed.  

The file is stored in ASCII format and the file structure is provided in Appendix A. 

 

Save As 

Save As saves a protocol to a new file name.  Any edited protocol file must be saved 

using either Save As or Save before the protocol can be executed.  The protocol file is 

stored in ASCII format and the file structure is provided in Appendix A. 

Save 

Saves a protocol file to the currently defined protocol file name.  The file is stored in 

ASCII format and the file structure is provided in Appendix A. 

Up 

Moves the selected protocol function up one position. 

 

Down 

Moves the selected protocol function up one position. 

 

Lmin and Lmax 

Lmin and Lmax are used to set limits on the movement of the lever system.  These limits 

are a hardware limit; 600A will not exceed these limiting values even if told to do so in a 

protocol.  Both Lmin and Lmax are set in terms of fractions of the initial length (Lo) and are 

absolute limits not relative ones.  Thus Lo must be set properly in order for Lmin and Lmax to 

perform correctly. 

 

Lmin is the minimum length that the controller can move to and has the range of  

-10Lo to +10Lo but a typical value would be in the range 0.0 to 0.5.  A setting of 0.2 Lo means 

that the length controller can move towards the force transducer such that the minimum length of 

the tissue will be 20% of the Lo value (a shortening by 80% of Lo).  Be aware that an Lmin 

value of 0.0 corresponds to the lever arm touching the force transducer. 

 

Lmax is the maximum length that the controller can move to and has the range of  

-10Lo to +10Lo but a typical value would be in the range 1.01 to 1.5 (1% longer than the initial 

length to 50% longer than the initial length).  Avoid setting Lmax equal to Lo (i.e., 1.0 Lo) as the 

controller may have trouble controlling to the initial length.   
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Be careful when setting the values of Lref, Lo, Lmin and Lmax.  Improper settings 

could result in damage to the force transducer or length controller.  For example, 

assume that the user incorrectly sets Lref and Lo to 2.00 mm but the preparation is 

only 1.00 mm long.  If Lmin is then set to 0.2 Lo the lever arm will be allowed to 

move to 0.2 x 2.0 mm = 0.4mm which is a shortening of 1.6mm.  However the 

preparation is only 1mm long so this actually means the lever arm can move to -

0.6mm past the point where the preparation is connected to the force transducer.  

This action will almost certainly result in damage to the force transducer and 

possibly also the length controller.  

 

In all cases Lmin must be less than Lmax.  Both Lmin and Lmax are stored in the 

protocol file.  Whenever a protocol is loaded Lmin and Lmax are set to the values found in the 

protocol.  Therefore it is important to set the correct Lmin and Lmax values before saving the 

protocol.   

 

Setting Lmin and Lmax values tightly around the desired range of lengths for the tissue is 

especially important if the protocol contains either force or sarcomere length commands.  In both 

of these cases the length is driven by the feedback algorithm that is trying to match the current 

force/SL with the commanded value.  This means that without proper Lmin and Lmax values the 

length controller is free to use its entire range of motion to achieve the desired force or 

sarcomere length. 

  

Improper setting of Lmin, Lmax, Lo and Lref can result in the program not being able to 

run a protocol.  If the settings of these parameters results in an Lref value that is outside of 

the currently defined Lmin and Lmax range the program will show a warning message and 

not execute the protocol. 

Under all circumstances Lmin x Lo < Lref < Lmax x Lo. 

 

Sampling Rate 

The protocol editor also includes a control to set the sampling rate for data collection.  

This sampling rate is used for writing data to disk and for graphing the results of a test.  The A/D 

hardware always samples at a higher rate and then block averages the data down to the selected 

sampling rate.   The maximum sampling rate is 20 kHz with the minimum of 10 Hz.   

 

Sample rates higher than 20 kHz can be achieved using the burst functionality.  Please 

refer to Section 4.9 Burst Menu for more information. 

Example Protocol 

As an example we will create a test protocol that will demonstrate stimulus, length and, 

force control.  The protocol enables data collection, stimulates the muscle, performs a force step, 

samples the length and holds it and then ramps the length back to the original length before 

disabling data collection.  The protocol then waits for 3.0 seconds and repeats the test 3 times.  

This example protocol is shown in Figure 25.  

 

Enter the protocol as shown in Figure 25 or load protocol file example2.pro which is 

located in the home/asi/pro directory.  As you enter the protocol you will note that the Step 
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number is automatically assigned for each line.  Also note the help text that is displayed in the 

box near the bottom of the screen.  This test box provides a brief description of each function 

including the expected number of parameters, the valid units and an example of its use.  

 

 

If the number of parameters entered for a function or the units entered are incorrect the 

program will not accept that protocol line when you press the Enter key.  In this case the 

selected line will not be updated. 

 

The functions in the protocol editor must occur one after then other.  The start time of 

each step must be greater than the end time of the previous step.  Since this is a common error, if 

you attempt to save or run a file that has this issue 600A will give a warning message. 

 

The minimum time between functions must be 0.1 ms.  The program will check the 

protocol before saving it and if there is a timing error a message will appear.  For example: if a 

Length-Ramp starts at 100.0 ms and has a ramp duration of 50.0 ms the next function cannot 

start until 150.1 ms (100.0 + 50.0 + 0.1).   

 

 

Failure to respect the timing in a protocol can cause the program to perform 

unexpected operations and in some cases the PC can “lock-up”. 
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Figure 25 Example Test Protocol 

Test protocols can be of any length and can contain multiple occurrences of the same 

function if desired. At the bottom of the screen there is a status line which displays error and 

status messages. 

 

Units  

Please note that for any function that includes length, force or time there are several 

possible units that can be used.  The units of length are: um, mm, Lo, Lf and volts.  The units of 

force are: mN, N, gm, kg, Fmax, Pa, kPa and volts.  The units of time are: ms and s.  As 

mentioned earlier in this section units can also have a + or – prefix which makes the unit relative 

instead of absolute.   

 

Delay Time in a Function 

Stimulus, Trigger and the Sample functions for length, force and SL are special functions 

in that the parameters include a delay time. The delay time is included to allow a 

stimulus/trigger/sample to be processed before the start of a length or force command but the 

action resulting from the stimulus/trigger/sample can be delayed to occur during the length, force 

or SL command.  Stimulation, triggers and sampling usually occurs during some other function 

such as a length or force function.  Since our system doesn’t allow a function to start before the 
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previous function has completed we needed a method of delaying the start of a stimulus, trigger 

and sample command.  Thus we included the delay time to get around this limitation.  Normally 

the user would specify the stimulus/trigger/sample function and set the delay time so that the 

stimulus/trigger/sample occurs during the following function.   

 

Stimulation and Trigger functions include two parameters; a Stimulus number and a 

delay time.  There are 10 possible Stimulus numbers defined on the Stimulus window and these 

are specified using the first parameter in the command as 1-10.    

 

Stimulus, Trigger1 and Trigger2 all use the same stimulus profile table.  In most cases the 

researcher will dedicate most of the Stimulus profiles to the Stimulus command and one or 

two of the profiles to trigger commands.  

 

Sample functions include two parameters; a sample number and a delay time.  There are 

10 possible sample numbers (memory locations) for each type of sample command and these are 

specified using the first parameter in the command as 0-9.  The zero (0) memory location is a 

special location in that it corresponds to the current value of length, force or SL.  In most cases 

when you want to sample the current length, force or SL you should choose a memory location 

between 1 and 9.   

 

Editing 

When editing or creating a protocol note the step is not updated until the user clicks on 

the parameter box and then presses the Enter key on the keyboard (make sure you use the main 

Enter key and not the one next to the numeric keypad).   

 

If you are satisfied with the protocol and there are no errors then either press the Save As 

button or the Save button to save the protocol.  Protocols must be saved before they can be run.  

Likewise the protocol must be saved prior to using the simulate function that allows you to 

review the protocol.   

 

The protocol can be reviewed by clicking the Simulate button on the main window and 

then clicking on the Start Test button.  This action will plot the protocol on the main screen in the 

data graph area.  When the Simulate button is pressed no control functions will be generated.  

  

4.6.2 Stimulus 

 The Stimulus menu item found at the top of the protocol window allows the user to open 

the Stimulus definition window as shown in Figure 26.  The Stimulus window is used to define 

both stimulation and trigger profiles.  Up to 10 separate stimulus profiles can be defined and 

these are stored along with the protocol information in the protocol file.  Thus an unlimited 

number of profiles can be defined but only 10 can be associated with any single protocol.  

Stimulus and trigger commands can be called at any time in a test protocol and can even be 

called repeatedly if desired.   

 

The ASI600A program provides all the signals necessary to completely control the 

electrical stimulation of muscle when used with an Aurora Scientific Inc. 700A series Stimulator.  
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When using other manufacturer’s stimulators the program can provide a TTL trigger pulse to 

start the stimulator.   

 

Referring back to the protocol defined earlier in this chapter (Figure 25) it can be seen 

that we have selected Stimulus Profile 9 and the stimulus function starts at 100 ms and is not 

delayed (delay set to 0 ms).  This means that the stimulus will start at the 100 ms mark of the test 

and will use the timing defined by stimulus profile 9. 

 

Stimulus profiles are defined by clicking on the Stimulus sub-heading under the Protocol 

main menu heading.  Up to 10 stimulus profiles can be defined.  Stimulus and Trigger are the 

same type of function and either function can call any table entry in the Stimulus table.   

 

The stimulus profiles are stored in the protocol file.  This means you don’t need to reenter 

the stimulus profile when you read in a protocol.  The table will automatically update with 

the stimulus profiles that were defined when the protocol was saved. 

 

 

 
Figure 26 Stimulus Profiles Screen 

The Stimulus Profile screen includes the following parameters: Pulse Width, Pulse 

Frequency, Frequency Duration, Train Frequency and Train Duration.  Table 3 shows an 

example Stimulus Profile and Figure 27 is this profile plotted.  Together the table and figure may 

help in understanding the various stimulation control parameters.   
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Pulse Width  

The Pulse Width defines the width of each individual stimulation pulse.  In our example 

each pulse is 1.0 millisecond (ms) wide.   

 

Table 3 Example Stimulus Profile 2 

Name Pulse 

Width 

(ms) 

Pulse 

Frequency 

(Hz) 

Frequency 

Duration 

(ms) 

Train 

Frequency 

(Hz) 

Train 

Duration 

(s) 

Stimulus 2 1.0 100.000 50.0 10.00 0.200 

 

Pulse Frequency  

 The Pulse Frequency is the rate at which the individual pulses occur.  This parameter 

sets the start of each individual pulse (in the example of Table 3 the Pulse Frequency is set to 

100 Hz or one pulse every 10 ms).  Examination of Figure 27 shows the 1.0 ms wide Pulse 

Width with a pulse starting every 10.0 ms at times 10, 20, 30, 40 and 50 ms.  

 

 
Figure 27 Stimulus Profile Corresponding to Table 3 

 

Frequency Duration  

 Frequency Duration is the time that the pulses set by Pulse Width and Pulse Frequency 

are active.  In our example Frequency Duration is set to 50 ms and therefore the 100 Hz 

stimulation pattern will end at the 60.0 ms mark of the test (10.0 ms start time + 50.0 ms 

Frequency Duration).  Since the Frequency Duration ends exactly at the time when the next pulse 
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should be produced this pulse is not produced.  If the user wanted a pulse to occur at the 60 ms 

mark then the Frequency Duration would need to be set to a minimum of 51.0 ms which would 

provide sufficient time for the program to produce this next pulse. 

 

Train Frequency   

Train Frequency is the rate at which the pulse trains get repeated.  In the example the 

Train Frequency is set to 10.0 Hz or a train starting every 100 ms.  Examination of Figure 27 

shows a train starting at 10 ms and another 100 ms later at 110 ms into the test.   

 

Train Duration  

Train Duration is the length of time that the trains will be output.  The example shows a 

Train Duration of 0.200 sec and this is shown on Figure 27.   

 

 

Caution – Do not assume that the program is not generating stimulus pulse 

simply because a protocol has finished. 

If the Train Duration is set to a time longer than the test protocol duration then 

stimulation will continue after the protocol finishes.  This feature can be useful if 

the researcher requires stimulation to continue after a protocol finishes.  The 

pacing of heart tissue is a good example of this. 

 

Example of Heart Stimulation 

 Assume that the heart tissue must be stimulated continuously for 30 minutes.  During 

this time the researcher will run a series of test protocols on the tissue.  A simple method of 

achieving this continuous stimulation would be to create a protocol that consists of a Data-

Enable function a Stimulus function, a Data-Disable function and a Stop function as shown 

below.   

0.0  Data-Enable 

0.0  Stimulus 2 0 ms 

100.0  Data-Disable 

101.1  Stop 

 

In this example the Stimulus function calls Stimulus profile 2 which is as follows. 

 

Table 4 Heart Pacing Stimulus Profile 

Name Pulse 

Width 

(ms) 

Pulse 

Frequency 

(Hz) 

Frequency 

Duration 

(ms) 

Train 

Frequency 

(Hz) 

Train 

Duration 

(s) 

Stimulus 2 0.3 100.000 50.0 2.00 900 

 

This profile defines a Train Frequency of 2.0 Hz (1 heart beat every ½ second) and a 

Train Duration of 900 seconds (15 minutes).  When this protocol is run it will complete 100 ms 

after it started but the stimulation will continue for 15 minutes longer.  The first set of pulses will 

start at the 0.0 ms mark which is exactly when the protocol starts and then will repeat every ½ 

second for 15 minutes even though the protocol ends after only 100 ms.   
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The researcher would typically want to run different tests on the tissue during the 15 

minute test period.  In order to do this the researcher has three options, 1) load and run a test 

protocol of interest whenever desired or, 2) use a sequence of protocols to automatically load and 

run different protocols or, 3) create a 15 minute test protocol that coordinates all of the tests with 

the stimulation.  Although all three options will work the best one is to create the protocols 

required for all of the desired tests plus the long term stimulation and then combine these in a 

single sequence.  Sequences are discussed in the next section.  Regardless of the option chosen 

the test protocols will require synchronization of the stimulation with other functions such as 

length, force or SL controls.  The 600A program can only synchronize control functions and 

stimulus commands within a single protocol.  Therefore, for our heart pacing example, each test 

protocol will need to restart the stimulation in order to be able to synchronize the control 

functions and the stimulus.  An important feature of the Stimulus function is that the execution of 

a Stimulus command will stop any stimulus command currently in effect.  Therefore all other 

protocols used for testing the heart tissue would also need to include a stimulus command in the 

test protocol.  Since we can’t guarantee that the Stimulus function in the current test protocol will 

exactly synchronize with the Stimulus function that is currently in effect we can handle this by 

pacing the heart for a sufficient number of cycles in each subsequent test protocol before we start 

collecting data.  In our heart pacing example we therefore start the Stimulus function and ensure 

several stimulations occur before the data collection.  Below is a simple protocol that starts 

stimulation and provides 6 stimulation events prior to starting data collection and then a further 2 

stimulation events prior to performing a quick release followed by a re-stretch.  Data collection 

starts at the 3 second mark and ends at the 5 second mark for a total of 2 seconds of data 

collected.     

0.0  Stimulus 2 0 ms 

3000.0 Data-Enable 

4025.0  Length-Step -0.3 Lo 

4200.0  Length-Ramp 1.0 Lo 

5000.0 Data-Disable 

5001.0 Stop 

 

The Stimulus Profile selected was the same as that used in the simple protocol created to 

start stimulation because once again we want the pacing to continue even after the protocol 

finishes.  You could also choose to use a different stimulus profile if desired.  When the Stimulus 

function is called in the test protocol the timing of the stimulation pulses will change to those 

specified by the Stimulus Profile specified.  In this example as long as the researcher starts a test 

protocol within 15 minutes of the previous protocol the stimulation will continue.  Of course the 

Train Duration can be specified to be different than 900 seconds if desired.  At the end of the test 

period when the pacing is to be turned off then another protocol can be run that simply contains a 

stimulation profile with a Train Duration of 0.00 seconds. 

4.6.3 Sequencer 

The Sequencer window is opened by clicking on the Sequencer menu tab at the top of the 

Protocol window.   
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 The Sequencer window allows the user to define a series of test protocols that can be 

executed in a given order.  Each protocol is executed in sequence and a data file is automatically 

created for each protocol in the sequence as soon as that protocol completes.  

   

The Sequencer screen can be divided into the following four sections:  

a) The top portion of the screen includes the sequence file name, protocol and data file 

directory, starting sequence number and a control to determine if the program saves data 

to a single file per protocol or to separate files for each frame in each protocol.  

b) The middle section allows the user to enable/disable each protocol defined in the 

sequence, to enter the names of the protocols to be included in the sequence, a button for 

each line that opens a file selector window, delay times and controls as to whether the 

timing between each protocol in the sequence is automatic or manual, the data file name 

prefixes to be used when automatically storing data and a File Status box which  indicates 

the results of the verify function shown at the bottom of the screen.  

c) Five control buttons are provided below the editing section to clear a sequence (Clear 

Sequence), verify protocols and file names (Verify Sequence), load an existing sequence 

(Load), and to save a sequence either to a new file name (Save As) or to the current name 

(Save). 

d) A Status Line is at the bottom of the screen. 

 

Figure 28 shows a sample sequence with six protocols, two of which are repeated twice.  

 

Directory Setup 

 Upon opening the sequence screen the user should first ensure that the protocol file 

directory and data file directory are entered correctly.  These directory locations are user 

selectable but must be existing directories.  All protocols used in a sequence must be stored in 

the same directory (e.g. /home/asi/pro).  If protocol files are selected that aren’t in the protocol 

directory then the sequence will fail verification.  The Protocol and Data File directories are 

stored with the sequence file and therefore will reset to the selected directories upon loading a 

sequence.  

 

Controlling How Sequencer Data Files are Stored 

Data file controls are provided to the right of the Sequence Number control at the top of 

the window.  These controls, one data file per test and one data file per frame, define how the 

data is stored during the running of a sequence.  If the one data file per test control is selected 

then the program will create a single data file for each protocol in a sequence.  If the one data file 

per frame control is selected then the program will create a single data file for each frame of each 

protocol in the sequence.   
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Figure 28 Sequencer Screen  

 

Adding Protocols to the Sequence 

 To add the protocol files to this sequence, click the square Browse button to the right of 

the Protocol File Name box which will open a file browser (see Figure 29). Click on the protocol 

file name to add it to the sequence. Alternatively you can manually enter the name of the file. Be 

aware that Linux is case sensative.  
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Figure 29 Select Protocol File Window 

Controlling Timing in the Sequencer 

A Delay Time (s) data entry box and a small square button to its right provide the timing 

controls for a sequence.  At the end of each protocol in a sequence the user has the option to 

either automatically start the next protocol in the sequence or to allow the user to manually 

determine when the next protocol starts.  When the button to the right of the Delay Time (s) 

column is pressed then the next protocol will start automatically after the time specified in the 

number column.  A time of 0 seconds causes the next protocol to start as soon as the previous 

one finishes.  Times must be entered in integral multiples of seconds.  If finer control of the 

timing is required then the two protocols should be combined into a single one because the 

internal timing in a protocol has a resolution of 0.1ms.  When the button is not pressed the timing 

will be manual.  When using manual timing the program will stop after each protocol is complete 

and the Next Test button located at the bottom of the main screen will un-gray.  When the user 

presses the Next Test button the next protocol in the sequence will start immediately.  
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Setting the Base Filename for Sequencer Data Files 

Next enter the prefix for the data file names that will be used when automatically saving 

the data from each protocol.  These data file name prefixes can be whatever the user wants but 

they must be unique names.  In addition the normal limits on file names exist, i.e., no special 

characters (~, !, @, #, $, %, ^, &, *, (, or )).   

 

 

A special caution for Linux is you should never include spaces in the file name as 

this will cause errors.  If you want to separate sections of the filename use an 

underscore such as my_1st_test. 

 

 
Figure 30 Sequencer Data File Error Screen 

After a sequence runs the program will automatically store the data in sequentially 

number data files that start with the prefix entered in the Data File Name field on the window.  

An example of file names with appended run numbers is shown in Figure 31.  In this figure you 

will note file names such as FC1_s001.dat, FC1_s002.dat, FC1_s003.dat, etc.  Each time the 
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sequence is repeated the program automatically appends the _s# to the prefix filename that the 

user has specified for that particular protocol in the sequence.  .   

 

 The current test number is derived from the largest test number appended to any of the 

data files defined in the sequence.  This means if you turn one or more protocols off for a 

few tests and then resume them, all of the numbers will still match.  

 

If there are no problems with the Verify Sequence then an OK will appear in the File 

Status text box to the right of each enabled protocol.   

 

Enabling Protocols in a Sequence 

Each of the protocols in a sequence can be enabled or disabled using the Enable button to 

the left of the protocol file name.  Pressing the button enables the protocol.  You don’t need to 

enable all of the protocols present on the list.  Simply enable the ones you would like to have 

included in the sequence.  When the sequence runs only the enabled protocols will be executed 

in numerically increasing order.  You can have up to 10 protocols defined in a sequence but you 

don’t need to enable all of them.  It is often convenient to list all of the main protocols used 

during an experiment and then save this sequence.  Now if a particular experiment calls for 

protocols 2, 4, and 8 you would only enable these protocols.  After enabling these selected 

protocols you could then save the sequence to a unique name.   

  

Verifying a Sequence 

Once you have completed entering the protocol names, timing information, data file 

names and enabled the protocols of interest press the Verify Sequence button located near the 

bottom of the screen.  The program will check for several conditions and if the protocol files 

exist, the data file names are unique and the sequence number is correct then an OK will appear 

in the File Status column on the right side of the window.  If there is a problem then the program 

will pop up an error window as shown in Figure 31.  This error window provides two options: 

Yes or No.  Selecting the Yes option will overwrite the existing data files with the same name.  

Selecting No will close the error window and return the user to the Sequencer editor.  At this 

point the user can either enter new data file names or change the Sequence Number found near 

the top of the window.  After making either of these changes, press the Verify Sequence button 

again.   

 

Repeating Protocols in a Sequence 

 You can also have a sequence that repeats a given protocol as many times as required.  

An example of this would be an experiment that required a pre-conditioning protocol followed 

by a test protocol and then followed by the same pre-conditioning protocol.  In order to repeat a 

protocol within a sequence you will need to specify the protocol on more than one line of the 

sequence.  

 

Saving a Sequence 

 Once you are satisfied with the sequence and it has been verified, press the Save As 

button to save the sequence to a new filename or press the Save button to save the sequence to 
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the current sequence name.  Sequences that have not been saved cannot be executed.  Sequence 

files are stored in ASCII format and the file structure is provided in Appendix A. 

 
 Figure 31 Sequencer Data File List 

Running a Sequence 

 After saving the sequence it can be run by pressing the Start Sequence button at the 

bottom of the main screen.  When a sequence is running the status bar at the bottom of the main 

window will inform the user of which protocol is executing and will provide a countdown timer 

to the start of the next protocol in the sequence. 
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4.7 Analysis Menu  

Refer to Chapter 6.0 Analysis. 

4.8 Scope Menu  

Refer to Chapter 7.0 Scope. 

 

4.9 Burst Menu 

 The burst menu button on the main window opens the Burst window.  The Burst window 

allows user to view and save burst data.  Burst data is sampled at a significantly higher rate; 

60,000 samples per second on each of the four channels instead of the normal 20,000 samples 

per second.  Burst data can be collected during a portion of a protocol by use of the Burst 

protocol function.  Figure 32 shows the burst window showing data from a length step. 

 
Figure 32 Burst window  

See Section 4.6.1 Protocol Editor for information about creating protocols and on the data burst 

function. 

 

 In order to setup a burst recording the user selects the desired data channel, the units of 

the data and the data file name for the burst data. 

 

4.10 Help Menu  

The Help menu contains two commands: ASI600A Help and About. 

ASI600A Help 

Opens a pdf viewer and displays this manual on the screen.  Links are included in the 

document to make it easier to navigate through the manual. 
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About 

 About provides information about the ASI600A program including the program version 

number, the real time A/D (RTAD) version number and contact information for Aurora 

Scientific Inc. 
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5.0 Force and SL Control 

 The Force & SL Control window provides an interface for controlling the software 

feedback control system built into the 600A program.  This feedback control system allows the 

program to control force or sarcomere length using length changes imposed on the tissue by the 

length controller.  Since every tissue has different properties and characteristics; this control 

panel allows the user to tune the settings to optimize feedback control for each individual 

experiment.  

 

 This section explains how to effectively use the Force & SL Control panel. Starting with 

the basics of how a feedback control loop works, how to measure the effect of a length change 

on force or sarcomere length and the function of the control parameters.  When properly set up 

and tuned the force feedback system can produce critically damped force or sarcomere length 

changes in as little as 1 millisecond.   

 

The Force & SL Control window is not used with Dual Mode Length Controllers (300C, 

305C, 309C, 310C) because these instruments have force control built into their 

electronics.  

5.1 Feedback Control Basics 

 A feedback control loop is necessary when you want to change a parameter that is not 

directly controlled. In this case, we want to change either the force or the sarcomere length by 

adjusting the overall length of the tissue.  

 

To understand the use of the Force & SL Control we will use an example of force control, 

the simplest of which is a force step.  A force step simply aims to change the tensile force on a 

preparation to a certain value, or by a certain value; change force to 3 mN, or decrease force by 2 

mN.  In this example we want to change the force to 3 mN, we start by reading the current force 

from the force transducer and then calculate the difference between the current force and the 

desired force which we will call the force error (Ferror).  The Ferror value tells us how much we 

want to change the force by but it doesn’t tell us anything about how much we need to move the 

length in order to obtain this force. So now we need a relationship that ties length change to force 

change.  In the program we call this dF/dL (change in force for a unit change in length) or 

stiffness. The stiffness is determined by imposing a known length change on the preparation and 

measuring the resultant change in force.  The determination of stiffness is discussed in greater 

detail in sections 5.2 Determining dF/dL(for force control) and 5.3 Determining dS/dL (for SL 

control). 

 

Assume we have a muscle tissue that we determine has stiffness (dF/dL) = 25 mN/mm.  

If this tissue is at a tension of 5mN and we want to do a force step to 3 mN it is obvious that we 

will need to shorten the tissue length. To determine how far to shorten the tissue the feedback 

control uses the force error (Ferror) and the stiffness (dF/dL) and performs a simple calculation to 

determine the length change (ΔL) that will produce the desired force.  The calculation is dividing 

the force error by the stiffness to obtain the required length change. 

 



INSTRUCTION MANUAL PAGE 70 OF 114 
MODEL 600A 

DIGITAL CONTROLLER  VER. 3.000 

  

 

  

File: 600A.v3.000.Manual.docx    Aurora Scientific Inc., 2003-2012 

Equation 1 

    
      
     

  
   

       
               

 

It turns out that if you try to eliminate the force error in one step (in our example by 

moving the full 80 um) the feedback control will overshoot the desired force and may also start a 

high frequency oscillation (ringing) of the length and the force.  In extreme cases this ringing 

will grow to the point where the feedback system will lose control and the tissue will be 

damaged.   To prevent overshoot and ringing the feedback control includes a gain term in the 

feedback equation.  The gain term is a multiplier of the calculated control response and in the 

case of Equation 1 it is a multiplier of the 80 um value.   

 

Equation 2 

     (
      
     

)      (
   

       
)                       

 

Typical values for the gain would be numbers between 0.1 and 0.5 but in all cases less than 1.  In 

most feedback control systems the controller will not use a gain of 1 because this would cause 

the control system to apply the entire correction in a single step.  A high gain term usually results 

in overshoot and instabilities (ringing or high speed oscillation of the length).  A low gain term 

usually results in a stable but slow response.  A large part of tuning the feedback control involves 

trying different gain factors and observing the results to obtain the best response.  

 

 To improve the stability of the feedback control and to eliminate small constant errors we 

need to add another term to Equation 2 that produces a length change that increases with time. 

When an integral is added to the control equation the control is improved for the case when large 

disturbances and noise are present on the signal and when there are time delays in the system.  

Equation 3 is the result of adding an integral term to Equation 2 and expressing the length 

correction as a function of time (t). 

 

Equation 3 

       
 

     
[            

 

  
∫           

 

 

] 

 

This equation includes an integral time constant (Ti) which controls the magnitude of the 

corrective action that arises from the integral calculation.  Equation 3 is in effect a proportional-

integral (PI) controller.  A PI controller takes control action based on past and present control 

errors.  The proportional term (controlled by the gain G) is the control action arising from the 

present value of the error and the integral term (controlled by the integral time constant (Ti)) is 

the control action arising from past values of the error.  The integral time constant determines 

how far back in time we look for our calculation of the integral control action.  An integral time 

constant of 0.0 ms removes the integrator from the feedback control.   
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 A major issue with many feedback control systems is instabilities that arise from noisy 

measurements of the error signal.  To minimize the chance of these instabilities arising we add a 

low pass filter to the calculated length change (ΔL) to produce a control signal that is filtered to 

remove the effect of noise.  The amount of filtering that we do is controlled by a filter time 

constant where larger values produce a greater filtering effect.  A filter time constant of 0.0 ms 

will produce no filter effect. 

5.2 Determining dF/dL 

 In order to determine the stiffness (dF/dL) of a tissue sample a known length change is 

imposed on the tissue and the resultant force change is measured.  The stiffness is the amount of 

force change per mm of change in the tissue length. As described in section 5.1 above, this value 

is required for a feedback control to work.  If you want to hold the force constant at a certain 

value, and it is not at that desired value, then the program must be able to determine how much 

to move the length controller to achieve the desired force. 

  

 

Ensure that the force transducer and length controller are calibrated before 

determining dF/dL.  See sections 4.4.2 Length Calibration and 4.4.3 Force 

Calibration for details on these procedures. 

 

5.2.1 Variable Stiffness 

 So far our discussion has assumed that the stiffness is constant, this is the simplest case 

and the easiest to control.  However the behaviour of muscle tissue can’t be described using a 

constant stiffness.  The stiffness varies with force in a more complex manner.  At this point our 

feedback control system does not allow stiffness to be entered as a function of force and 

therefore, in most cases, the force controller settings will need to be adjusted as the force level 

changes.  There are a few methods of compensating for the variable stiffness: (a) measure the 

stiffness at the desired force level, (b) determine the range of stiffness exhibited by the tissue 

from relax to tetanus (full activation) and then manually adjust the stiffness variable as you 

perform the experiment, (c) determine some “average” stiffness and then adjust the other 

controller settings to compensate for higher or lower stiffness depending on the protocol you are 

running.  Regardless of the method chosen, experience that comes from use will be your best 

guide and be prepared to adjust stiffness and control variables as your experiment progresses.  

Typically this may involve running a particular force control protocol, observing the results, 

adjusting the stiffness and controller settings and then re-running the protocol to obtain the best 

results.   

 

5.2.2 Method for Measuring dF/dL 

For this method let’s assume that we want to measure the passive stiffness of the muscle 

tissue.  The method is the same for measuring active stiffness the only difference is the muscle 

needs to be activated (stimulated) before the measurement is made.   
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Start by opening the Scope menu so that you can observe how the Length In and Force In 

signals change during the measurement of dF/dL.  Next mount a tissue sample and adjust the 

resting tension to the desired level.   

 

 

If the tissue is slack the determination of dF/dL will underestimate the stiffness and 

the force control will not work properly. 

 

 
Figure 33 Force & SL Control Window 

Now open the Force & SL Control window (Figure 33) by clicking on Calibrate→ Force 

& SL Control menu item from the main window.   Set the Step Size for the length change that 

will be imposed during the stiffness measurement.  The Step Size can be a positive (stretch) or a 

negative (shorten) value depending on the conditions under which you are measuring the 

stiffness.  If the tissue is fully activated then you will not likely want to impose a further stretch 

on the tissue which would risk damaging the tissue.  Under this circumstance it would be better 

to use a shortening movement.  Likewise if you are measuring the passive stiffness then the fibre 

is likely near slack and a stretch movement is more appropriate.   

 

Step Size  
Step Size is the change in length to be imposed on the tissue which will produce a force 

change on the preparation.  The step size is always set in microns (um) and can be a positive 

(stretch) or a negative (shorten) number.  Typically the Step Size should be in the range of 0.5-

1.0% of the Initial Length (Lo).  For a 2mm fibre a step size of 10-20 um would be reasonable.   

 

 

Take care to limit the Step Size as large values can damage the tissue and/or the 

force transducer especially when the tissue is being stretched.   
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It is better to start with a small value and observe the change in force resulting from that 

length change.  Then incrementally increase the Step Size value observing the increased force 

change.   Try to avoid length changes that result in very small force changes (changes that are 

only a few percent of the full scale range of the force transducer) as there will be more error in 

the measurement.  In general you want to produce force changes that are within the range seen 

during an experiment. 

 

The length change profile is a ramp from the current length by the Step size followed by 

a constant length data acquisition period (Hold Time) which is then followed by a ramp length 

change back to the starting length.  The Ramp Time variable determines the slope (time it takes 

to change the length by the Step Size) for both the initial length change and for returning the 

tissue back to the starting length.  Ramp Time is measured in milliseconds (ms).  Based on the 

type and size of the tissue you may want to vary the Ramp Time.  Some tissues exhibit rapid 

force recovery after a length change and therefore, for these tissues, you may want to make the 

Ramp Time quite short.  Likewise for larger preparations there may be a concern that a rapid 

stretch would damage the tissue so, in this case, a longer Ramp Time would be appropriate.   

 

The Hold Time is the time that the length is held at the new length.  Both length and force 

are measured before the Step Change and during the Hold Time.  These measured changes in 

length and force are used to calculate stiffness.  Some experimentation with Hold Time may be 

required to obtain the best measure of stiffness.  Ensure you use Scope to actually observe the 

behaviour of the length and force signals during the measurement as this behaviour will provide 

clues as to changes that may need to be made to Step Size, Ramp Time and Hold Time. 

 

Ramp Time 

 Ramp time is specified in milliseconds and is the amount of time taken to change the 

length of the preparation by the specified Step Size.  Some experimentation may be required to 

determine a Ramp Time that yields the best measure of stiffness.   

 

Hold Time 

 Hold time is measured in milliseconds and is the amount of time taken to hold the length 

of the preparation after it has been stretched in order for the muscle to stabilize. A Hold Time 

that is too short may not allow the preparation to stabilize before a force reading is taken.   A 

Hold Time that is too long may allow the force to change by an unacceptable amount before the 

stiffness measurement is made.  

 

See Figure 33 for reasonable starting values for Step Size, Ramp Time and Hold Time. 

Once these parameters are set, click the Record dF/dL button. Three values will update, Force 1, 

Force 2, and dF/dL.  It is recommended that you press the Record dF/dL button a few times to 

ensure the values remain consistent.  A little deviation between measurements is normal and will 

not adversely affect the force control function. 

  

Force 1 (mN) – Force 1 is the initial force recorded before the length change is made, it is 

measured in mN.  This is a text readout box that shows the measured value, the user can’t change 

this text. 
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Force 2 (mN) – The force recorded after the length change is made, measured in mN.  This is a 

text readout box that shows the measured value, the user can’t change this text. 

 

dF/dL (mN/mm) – Calculated stiffness which is the force change per unit length change, 

expressed in units of mN/mm.  This value can be overwritten by the user.  If you have made a 

series of stiffness measurements at different force levels it is sometimes more convenient to 

simply enter the stiffness that corresponds to the conditions expected in the next protocol you 

intend to run. 

5.3 Determining dS/dL 

 The sarcomere feedback control works in a similar manner to the force feedback control.  

Instead of stiffness we substitute dS/dL or the change in sarcomere spacing due to a change in 

tissue length. The units of dS/dL are um/mm, the change in sarcomere spacing measured in 

microns divided by the change in tissue length measured in mm. 

  

 

Ensure that the 901 HVSL 2 sarcomere length measurement system and the 

length controller are calibrated before determining dS/dL.  See section 4.4.2 

Length Calibration and the ASI 901 Instruction Manual for details on these 

calibrating these instruments. 

 

 To determine dS/dL use the same method as outlined in section 5.2 Determining dF/dL 

above.  As with the stiffness measurement there will be a variability of dS/dL depending on the 

activation of the muscle tissue.  Activated tissue can be expected to have a much higher value of 

dS/dL than non-activated tissue.  As with the determination of stiffness select Step Size, Ramp 

Time and Hold Time to provide reasonable changes in length and in sarcomere spacing.  We 

recommend using a Step Size in the range of 0.5-1.0% of the Initial Length (Lo).  

 

See Figure 33 for reasonable starting values for Step Size, Ramp Time and Hold Time. 

Once these parameters are set, click the Record dS/dL button. Three values will update, SL 1, SL 

2, and dS/dL.  It is recommended that you press the Record dS/dL button a few times to ensure 

the values remain consistent.  A little deviation between measurements is normal and will not 

adversely affect the sarcomere length control function. 

 

SL 1 (um) – SL 1 is the initial sarcomere length recorded before the length change is made, it is 

measured in um.  On the Force & SL Control window is a text readout box that shows the 

measured value of SL 1, the user can’t change this text. 

 

SL 2 (um) – SL 2 is the sarcomere length recorded after the length change is made, it is 

measured in um.  On the Force & SL Control window is a text readout box that shows the 

measured value of SL 2, the user can’t change this text. 

 

dS/dL (um/mm) – Calculated dS/dL which is the SL change per unit length change, expressed 

in units of um/mm.  This value can be overwritten by the user.  If you have made a series of 

dS/dL measurements at different activation levels it is sometimes more convenient to simply 
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enter the dS/dL that corresponds to the conditions expected in the next protocol you intend to 

run. 

5.4 Force & SL Control Parameters 

There are four parameters used to tune the force feedback control and three to tune the 

sarcomere length feedback control.  The parameters associated with the force controller are listed 

under the title Force Controller Settings and they are: Gain, Integral Tc (ms), Filter Tc (ms) and 

Linear Range (%).  The parameters associated with the sarcomere length controller are listed 

under the title SL Controller Settings and they are the same as the force controller parameters 

with the exception that there is no Linear Range (%) parameter.  These control parameters are 

found in the top centre and top right sections of the Force & SL Control window.  There are two 

distinct sets of parameters and even though they have the same names they are unique to the 

force and sarcomere length command functions used in protocols.  If you place a sarcomere 

length command in a protocol then the program will use the Gain, Integral TC and Filter TC 

values found under the SL Controller Settings heading.  This is likewise for force control; there 

are two unique sets of parameters.  This allows the researcher to create protocols that have both 

force control and sarcomere length control in the same test protocol (but not at the same time). 

 

The control parameters for both force and sarcomere length depend on the model of 

length controller and force transducer being used, the tissue type and size, the tissue stiffness or 

dS/dL measurement, and the amount of tissue activation.  Typically you will find that the control 

parameters will need to be adjusted for each different protocol you run.  In practical terms this 

means that a protocol to generate a force clamp to 20% of the Fmax value and one to generate a 

force clamp to 80% of Fmax will need different values for the control parameters.  

 

To further complicate the determination of control parameters you will also find that the 

individual control parameters affect each other.  A change in one of the parameters will often 

require a change in one or all of the other parameters.  Tuning the feedback control is an iterative 

process where you try a safe set of parameters, observe the results and then adjust the parameters 

to optimize the results.  With time and experience you will find that the tuning becomes faster 

and easier and you will develop a “feel” for the correct values for the parameters.   

 

The rest of the discussion in this section will refer to the results obtained using the force 

clamp protocol shown in Figure 34.  Initially we will start with the settings shown in the Force & 

SL Control window of Figure 35.  

 

The protocol we have selected is a force step.  Briefly, what this protocol does is: 

 

1. Data-Enable will start the collection of data. 

2. Length-Sample will measure the length at 490 ms into the protocol (90 ms start of 

command + 400 ms delay) and store the measured value in storage location 1. 

3. Force-Step will make a step change in the force from the current tensile force to the 

desired force of 1.6 mN and will hold that force regardless of what the tissue does.  This 

Force-Step command uses force feedback to control the length controller and the 

parameters that we are discussing in this section only affect this command. 
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4. Length-Hold will stop the Force-Step command by issuing a length command to keep the 

length of the preparation at the value measured by the Length-Sample command issued in 

step 2 of the protocol.   

 

 

Protocol functions that control length, force and sarcomere length remain 

active until another function is called or the protocol ends.  Therefore to end a 

force command you need to issue a different force command, a length command or 

a sarcomere length command.  In most protocols force and SL control should be 

ended by issuing a length command. 

 

5. Length-Ramp will return the length to the initial starting length (Lo) using a ramp 

function that takes 300 ms to complete. 

6. Data-Disable will stop the collection of data. 

 

Located near the middle of the protocol windows are two very important parameters that 

need to be understood before doing anything with force and SL control.  These parameters are 

Lmin and Lmax and they provide a hardware limit on the range of motion of the length 

controller.  The numbers entered next to the Lmin and Lmax labels are multipliers of the 

currently defined Lo value which is shown at the top of the Protocol window.  For the example 

shown in Figure 34 Lmin is 0.997 x Lo = 0.997 x 5 mm = 4.985mm.  Likewise Lmax is 1.200 x 

Lo = 1.200 x 5 mm = 6 mm.  

 

It is important to understand that Lmin and Lmax set hardware limits on the length that stay 

in effect regardless of what either the user tells the length controller to do (via commands in a 

protocol) or what the feedback control tells the length controller to do (via the feedback 

calculation of length required to obtain the desired force or SL).  Because Lmin and Lmax are 

hardware limits you can use them to minimize unstable behaviour of the force and SL feedback 

control.  As has been mentioned earlier in this chapter if you specify control settings that are 

inappropriate for your particular equipment and tissue or if you measure the stiffness (dS/dL 

when dealing with sarcomere length control) incorrectly, the result can be instability which 

results in large movements of the length controller.  These large movements could damage the 

tissue and even the equipment.  By setting tight limits on Lmin and Lmax you will prevent these 

large movements from happening.  
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Figure 34 Protocol Window 

 

When first using force or SL feedback control we strongly recommend that you set very 

tight limits on Lmin and Lmax (we would suggest Lmin = 0.8 and Lmax = 1.1 as 

reasonable starting values).  Limiting the range of movement of the length controller will 

protect the tissue and the instruments from potential damage should the Force & SL 

Control become unstable.   
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Figure 35 Force and SL Control Window 

Several graphs of force control signals are shown on the next few pages.  These were all 

obtained using a 322C high speed length controller and a 400A force transducer mounted on an 

801C Small Intact Muscle Test Apparatus. A multi-threaded piece of elasticized string was used 

in place of the muscle tissue (a rubber (elastic) band provides a good practice fibre). Because the 

elasticized string could not generate active force we needed to stretch it to create force and then 

perform force clamps to lower the force to the desired level.   

 

Before attaching muscle tissue or a rubber band to the force transducer, ensure the 

transducer is turned on.  Circuits are included in the force transducer that will produce an 

alarm sound if you overload the transducer.  Listen for this sound and take reasonable 

caution while mounting the tissue.   

 

5.4.1 Gain 

Gain is the first parameter shown in the controller settings sections. The gain parameter, 

in conjunction with the stiffness (dS/dL for sarcomere control), produces a corrective length 

control signal that is proportional to the current error between the actual force (SL) and the 

desired force (SL).  The Gain parameter can vary from 0.0 to 1.0 but a safe starting value would 

be between 0.1 and 0.3.  

 

The Gain parameter is used in conjunction with the measured stiffness (dS/dL for 

sarcomere control) to generate the length control signal.  If you find you need very large 

(close to 1.0) or very small (close to 0.0) values for Gain then this is a good indication that 

the stiffness (dS/dL) is not correct for the tissue and experimental conditions.  
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Figure 36 Force Clamp with Gain=0.5, Integral TC=0.2, Filter Tc=0.4  

With the protocol shown in Figure 34 and the settings shown in Figure 35 the result of 

running the protocol is shown in Figure 36. The top graph, shown in blue, is the length of the 

preparation measured in microns. The bottom graph, shown in red, is the tensile force measured 

in mN.  The figure shows a constant length at the start of the test followed by a rapid clamping of 

the force which starts at the 100 ms mark.  During the force clamp (from 100 ms to 600 ms) the 

force remains constant.  At the 600 ms mark length control is reinstated and the length is ramped 

back to the starting length.     

 

Examination of the results shows that the force clamp occurs in a short time with no 

overshoot or oscillation of the force signal during the clamping period.  This is a good indication 

that the Gain and other parameters are set correctly.  We suggest you use Analysis to zoom in on 

the start of the force clamp as this can provide a clearer picture of how good the controller 

settings are.  Figure 37 is the same data shown on the Analysis window with the display zoomed 

to show the results from 90 to 130 ms of the test.  As can be seen there is a stable force clamp 

that takes about 10 ms to clamp the force to 1.6 mN (clamp starts at 100 ms and is at the 1.6mN 

level by about the 110ms mark).  No overshoot or oscillation of the force signal can be seen. 
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Figure 37 Analysis of Force Clamp with Gain=0.5, Integral TC=0.2, Filter Tc=0.4 

 

Now let’s look at the effect of changing the Gain parameter.  We may want to improve 

the performance by reducing the time it takes to clamp the fibre to the desired force.  If this is the 

goal then we will need to increase the Gain.  Figure 38 shows the force clamp response when we 

increase the gain from 0.5 to 0.9.  You will note that the desired force is reached in just 4 ms but 

the force now overshoots the desired force and doesn’t settle until about the 108 ms mark of the 

test, taking a total of 8 ms to stabilize. Thus an increase in the Gain parameter speeds up the 

control action but leads to overshoot on the force if the Gain is too high.   
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Figure 38 Effect of Increased Gain on the Force Clamp 

 Gain=0.9, Integral TC=0.2, Filter Tc=0.4 

 What is the effect of decreasing the Gain parameter?  Figure 39 shows the test results 

when the Gain is set to 0.3.  In this case the force clamp is stable (no overshoot, no oscillation) 

but it takes about 20 ms to reach the desired force.   There is clearly a balance to be had between 

speed and stability when changing the Gain parameter.  A decrease in the Gain parameter slows 

down the control action and provides more stable results.   
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Figure 39 Effect of Decreased Gain on Force Clamp 

Gain=0.3, Integral TC=0.2, Filter Tc=0.4 

 Adjusting the Gain parameter involves finding the highest Gain setting that will provide a 

stable force without introducing overshoot or oscillation.  Figure 40 shows the force clamp when 

using a Gain setting of 0.6.  The length controller is able to change the force to the desired force 

in about 7 ms.  With all other Force Control parameters held constant we have determined the 

optimal value for the Gain parameter for this particular tissue in just three or four iterations.  

With experience and time you will learn how to quickly and accurately determine the Gain value 

based on the response you observe.   
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Figure 40 Optimal Gain Setting 

Gain=0.6, Integral TC=0.2, Filter Tc=0.4 

5.4.2 Integral TC (ms) 

Integral TC (ms) is the second parameter in the Force & SL Control window located in 

both the Force and SL Controller Settings sections. Integral TC stands for the Integral Time 

Constant and it is used to eliminate small, steady-state errors in the controller.  Without the 

integral term a small, constant difference between the measured force and the desired force 

would not be eliminated.  The addition of an integrator has the disadvantage that it can slow the 

overall response and also introduce unwanted oscillations in the control signal.  Refer back to 

Figure 37 for the response when the Integral TC is set for 0.2 ms, the Gain set to 0.5 and the 

Filter TC set to 0.4 ms.   

 

Now let’s look at the effect of changing the Integral TC parameter.  Some of the reasons 

for adjusting the Integral TC include: increasing the accuracy of the control and reducing 

oscillations.  Let’s first look at what happens when the Integral TC is increased.  Figure 41shows 

the force clamp response when we increase the Integral TC from 0.2 to 0.4 ms.  You will note 

that it takes longer to reach the desired force, 20 ms instead of the initial 10ms.   However the 

response is stable and accurate.  Thus an increase in the Integral TC parameter slows down the 

control action, reduces oscillation and improves accuracy.     
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Figure 41 Effect of Increasing Integral TC  

Gain=0.5, Integral TC=0.4, Filter Tc=0.4 

 What is the effect of decreasing the Integral TC parameter?  Figure 42 shows the test 

results when the Integral TC is reduced to 0.1 ms.  The most noticeable effect is the force clamp 

becomes unstable with both an overshoot and an oscillation of the force signal.  The less 

noticeable effect is that the time required to reach the desired force is reduced to 15 ms.  As was 

found when adjusting the Gain parameter, adjusting the Integral TC is also a balance between 

speed, stability and accuracy.  A decrease in the Integral TC parameter speeds up the control 

action but provides more unstable results.   
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Figure 42 Effect of Decreasing Integral TC 

Gain=0.5, Integral TC=0.1, Filter Tc=0.4 

 With the Integral TC set at 0.15 ms, the overshoot is greatly reduced and the force is 

clamped in 10 ms. An optimal value would be somewhere between 0.15 and our starting point of 

0.2.  Figure 43 shows the force clamp when using an Integral TC setting of 0.15.  The length 

controller is able to change the force to the desired force in about 10 ms.  With all other Control 

parameters held constant we have determined the optimal value for the Integral TC parameter for 

this particular tissue in just two or three iterations.  With experience and time you will learn how 

to quickly and accurately determine the Integral TC value based on the response you observe.  

Adjusting the Integral TC parameter involves finding the lowest Integral TC setting that will 

provide a stable force without introducing overshoot or oscillation.    
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Figure 43 Integral TC Optimal 

Gain=0.5, Integral TC=0.15, Filter Tc=0.4 

5.4.3 Filter TC (ms) 

Filter TC (ms) is the third parameter in the Force & SL Control window located in both 

the Force and SL Controller Settings sections. Filter TC stands for the Filter Time Constant and 

it is used to stabilize the control output especially with noisy signals.  Without the filter term the 

control signal will react to noise on the force signal.  This reaction can result in major 

instabilities that make it all but impossible to obtain a force clamp.  Since in the real world there 

is always noise on measurements it is imperative that the Filter TC value is always greater than 

0.0.  The addition of the filter on the control signal has the disadvantage that it can slow the 

overall response but this is more than overcome by its ability to stabilize the output.  Refer back 

to Figure 37 for the response when the Gain was set to 0.5, and the Integral TC was set to 0.2 ms 

and the Filter TC was set to 0.4 ms.   

 

Now let’s look at the effect of changing the Filter TC parameter.  The main reason for 

adjusting the Filter TC is to improve the stability of the control which will reduce oscillations.  

Let’s first look at what happens when the Filter TC is decreased.  Figure 44shows the force 

clamp response when we decrease the Filter TC from 0.4to 0.1 ms.  You will note the 

pronounced overshoot and oscillations.  Thus a decrease in the Filter TC parameter reduces 

stability.     
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Figure 44 Effect of Decreasing Filter TC 

Gain=0.5, Integral TC=0.2, Filter Tc=0.1 

 Figure 45 shows the effect of increasing the Filter TC setting to 0.8 ms.  The instabilities 

are eliminated but the time to reach the desired force is greatly increased to about 25ms.   

 

With all other Control parameters held constant we have determined the optimal value for 

the Filter TC parameter for this particular tissue in just two or three iterations.  With experience 

and time you will learn how to quickly and accurately determine the Filter TC value based on the 

response you observe.  Adjusting the Filter TC parameter involves finding the lowest Filter TC 

setting that will provide a stable force without introducing overshoot or oscillation.    
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Figure 45 Effect of Increasing Filter TC 

Gain=0.5, Integral TC=0.2, Filter Tc=0.8 

5.4.4 Linear Range 

The Linear Range control parameter is only found in the Force Controller Settings 

section of the Force & SL Control window, it does not apply for sarcomere length control.  As 

mentioned earlier in this chapter the stiffness of muscle tissue varies with load and with level of 

activation.  We have attempted to compensate for the changing stiffness using a simple method 

that approximates the load-stiffness relationship as shown in Figure 46.  At low forces the 

stiffness is assumed to be constant and then at some threshold force stiffness starts to increase 

linearly with force.   

 

The control parameter called Linear Range sets the threshold force.  Linear Range is 

expressed as a percentage in the range from 0-100%.  When Linear Range is set to 0% the 

stiffness varies linearly over the range from zero to Fmax.  When Linear Range is set to 100% 

then the stiffness is constant over the full range of forces from zero to Fmax.  The program uses 

the values Fref and Sref to calculate the slope of the stiffness curve.  Fref is the Force 1 value 

measured when the stiffness was determined and Sref is the measured stiffness dF/dL.  
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Figure 46 Model of Stiffness as a Function of Force 

Initially set Linear Range to 100% and tune the rest of the force control parameters.  

Then try running protocols with force commands that control forces to different force levels and 

observe the results.  If you find that the force control becomes unstable as the desired force 

increases then lower the Linear Range percentage.  This will have the effect of increasing the 

stiffness at higher forces which should improve the stability of the force control.   

 

At this point the Linear Range control is experimental and we welcome your feedback to 

allow us to improve the 600A program.  Watch for future releases of the program which will 

include improvements to the way we handle stiffness as a function of force.   

 

5.4.5 Best Practices for Setting Control Parameters  

The following is a quick procedure that you can use when tuning force and sarcomere 

length control parameters.  In the procedure you can substitute sarcomere length whenever you 

see force and dS/dL whenever you see dF/dL or stiffness. 

 

1) Mount the tissue and make sure you accurately set the reference length, initial length and 

zero load.  

2) Measure dF/dL with the tissue at resting tension or resting SL.  This will provide you 

with the lowest stiffness you can expect with this particular tissue. 

3) If you are using a permeabilized tissue then fully activate the tissue in calcium and 

measure dF/dL again.  This will provide you with the highest stiffness you can expect 

with this particular tissue.  At this point you also want to set the Fmax value for your 
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tissue which you should be able to get from the Scope screen when the fibre is fully 

activated.  

4) Manually set the dF/dL value on the Force & SL Control window to a stiffness value 

between the two values measured. 

5) Set Gain = 0.1, Integral TC (ms) = 0.5, Filter TC (ms) = 0.5 and run a protocol that 

includes the force control commands you wish to use during your experiment. 

6) Observe the Length In and Force In signals using Analysis and zoom into where the force 

control action takes place.  If the response is very slow then increase the Gain parameter 

and repeat the protocol.  Continue to increase the Gain until the response is as fast as 

possible but still stable. 

7) Lower the Integral TC value until you start to see overshoot and other instabilities occur 

then increase the value until these overshoot and instabilities are gone.  Note: at this point 

you may need to go back and lower the Gain value since changes to Integral TC and 

Filter TC affect Gain. 

8) Lower the Filter TC value until you start to see overshoot and other instabilities occur 

then increase the value until these overshoot and instabilities are gone.  Note: at this point 

you may need to go back and lower the Gain value and possibly increase the Integral TC 

value since changes to Filter TC can affect both Integral TC and Gain. 

9) Typically you will want the highest Gain and lowest Integral TC and Filter TC that 

results in fast, accurate and stable force control.   

10) If your test will involve force control at different force levels (for example, force clamps 

to 30%, 20%, 10%, 5%, etc. of Fmax) then you should test the force control protocol at 

these forces and observe the results.  If the force control becomes unstable at higher 

forces then lower the Linear Range % value and repeat the test.  If you can’t keep the 

response stable at varying force levels by using the Linear Range control then you may 

need to use alternative values for Gain, Integral TC and Filter TC as the force level 

changes.  However you may find that you can’t achieve the desired response with these 

parameters.  If so then return these parameters to the values that you had after step (9) 

and alter the stiffness value shown on the Force & SL Control window.  Changing the 

stiffness value is equivalent to making a major change to the Gain setting; be careful 

when changing the stiffness.  From the range of stiffness you previously measured you 

may be able to make a reasonable guess of what the stiffness value should be as force 

varies.  Please note that you may need to change Gain, Integral TC and Filter TC when 

you change the stiffness.  

11) Once you have gained some experience with tuning the feedback control you will 

develop a “feel” for what you need to do to achieve optimal tuning.  Often you will only 

need to make minor changes to the control parameters when you change tissue. 

12) Remember that the overall gain value for the control equation is actually the Gain value 

divided by the stiffness value.  Therefore if you have the wrong stiffness you won’t be 

able to properly tune the system regardless of the Gain value you set.  Anytime you find 

you have a gain very close to either 0.0 or 1.0 this is an indication that the stiffness is not 

set correctly.  Gain values close to 0.0 indicate the stiffness is too low whereas Gain 

values close to 1.0 indicate the stiffness is too high. 

13) Integral TC is mostly affected by the model of length controller and force transducer you 

are using.  Once you find an appropriate value for Integral TC it shouldn’t change that 

much (±0.1 or ±0.2) for different tissues.   



INSTRUCTION MANUAL PAGE 91 OF 114 
MODEL 600A 

DIGITAL CONTROLLER  VER. 3.000 

  

 

  

File: 600A.v3.000.Manual.docx    Aurora Scientific Inc., 2003-2012 

14) Filter TC is mostly affected by the noise on the force transducer signal and therefore the 

value you need is strongly related to the actual force transducer you are using.  Once you 

find an appropriate value for Filter TC it shouldn’t change that much (±0.1 or ±0.2) for 

different tissues.  The most difficult control task is when you are trying to control force to 

values close to the zero.  At this point even small noise on the force signal is large 

compared to the absolute force and you may need to increase Filter TC to obtain 

optimum results.  
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6.0 Analysis 

 Analysis provides a set of analysis, graphics and storage functions.  The Analysis 

window allows users to load, alter and export test data.  The File dropdown menu contains these 

functions as well as a toggle to show or hide the control panel on the left side. Details of each of 

these menus are presented in the next section. 

 

Analysis also allows the user to control the variables to be plotted, the units to use, the 

time base of interest, Zoom controls, Filter Length (for Velocity and dF/dt), a Frame spin button 

and controls for Auto Loading tests and for Locking and Unlocking the time interval. The 

colours that are used to plot data are consistent with all of the other plots; they can be set in the 

display settings menu of the main screen (see 4.3.1 Display Settings for details). The Analysis 

screen also includes a button to toggle a Digital Readout on/off.  All of these controls are 

discussed in detail in the following sections. 

 

 
Figure 47 Analysis Screen 

6.1 File Menu 

 The Analysis window File menu drops down to provide access to the following items. 

 

Show Controls 

 Show Controls is a toggle control that allows the user to hide or show the controls on the 

left side of the window.  Hiding the controls maximizes the data plotting area.   
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Load Data 

 Load Data allows the user to open a data file stored on the PC.  The data files can be files 

taken by the main program using the Start Test or Start Sequence button or they can be data files 

stored using Scope. 

Load Current 

The Load Current menu item will load the data most recently collected using the main 

program into Analysis.  The data doesn’t have to be saved in the main program before importing 

it into Analysis.  This allows you to plot the signal in Analysis and do some preliminary analysis 

on it before deciding whether you want to save the data or not.  

Export Data 

The Export Data menu item will output the data currently shown on the Analysis screen 

to an ASCII text file.  The data will be output exactly as shown on the screen with the channels 

selected, the time base selected, the units selected and the filtering selected.  Appendix A shows 

the file format for these export files.  

Close 

 The Close menu item closes the Analysis window. 

6.2 Onscreen Controls 

 Along the left side of the Analysis window are a series of buttons that control the plotted 

variables on the Analysis window.  

Units Selection 

 In the upper left part of the window are unit selection controls for Length, Force and 

Time.  Clicking on the button next to the variable allows the user to specify Length, Force and 

Time units.  The current data display is automatically updated whenever the units are changed.   

 

The Velocity and dF/dt are presented in terms of the units specified for length, force and 

time.  Sarcomere length is always plotted in microns (um) and Auxiliary channels are 

plotted in the units set on the Models Attached window.  Stimulus and triggers are plotted 

as 0/1 (on/off) values.  

 

Plotted Variable Selection 

 The plotted variables are located to the right of the Units and Color area of the window 

and are shown as input signals at the top and output signals at the bottom.   

 

Input and output values for a particular variable are overlaid on the same plot.   

 

The graphics window automatically uses the maximum available space to plot the 

selected variables.  In other words, if the user only selects Length as the plotted variable then the 

length vs time graph will use the entire plotting area.  If the user selects Length and Force 

variables to be plotted then the plotting area is split into two equal size horizontal windows, one 

for each variable.  Thus the number of graphs plotted can range from 1 to 6 depending on the 

number of variables selected.  Length, Force, Velocity, dF/dt and SL are all plotted on individual 
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graphs.  Aux 1 and Aux 2 share a single graph as do Stimulus, Trigger1 and Trigger 2.  Clicking 

on the box next to the variable toggles the plot on and off. 

 

Signals In 

L Plots Length In versus time on the Analysis graphics window 

F  Plots Force In versus time on the Analysis graphics window  

V Plots Velocity In (calculated from Length In) versus time on the Analysis 

graphics window 

dF/dt Plots dF/dt In (calculated from Force In) versus time on the Analysis graphics 

window 

SL  Plots SL In versus time on the Analysis graphics window  

Aux 1/Aux 2  Plots the Auxiliary channels 1 and 2 versus time on the Analysis graphics window 

 

Signals Out 

L Plots Length Out (the actual length control values) versus time on the Analysis 

graphics window 

F Plots Force Out (the actual force control values) versus time on the Analysis 

graphics window 

V Plots Velocity Out (the derivative of the actual length control values) versus time 

on the Analysis graphics window 

dF/dt Plots dF/dt Out (the derivative of the actual force control values) versus time on 

the Analysis graphics window 

SL  Plots SL Out versus time on the Analysis graphics window 

Stim Plots Stimulus, Trigger 1 and Trigger 2 versus time on the Analysis graphics 

window 

Readout Toggles the display of the digital readout for each channel plus the time axis.  A 

dual readout of Y-axis values is presented in the top right corner of each graph.  

The colour of the readout matches the selected colour for the variable.  The time 

readout is presented on the right end of the time axis.   As the cursor is moved 

back and forth across the plot window the readouts change to show the time and 

Y-axis value at the cursor location.  

 

Zoom Controls 

 Below the Color section are graph zoom controls, T Start and T End.  There are two 

methods of zooming: a) enter the desired T Start and T End times and the graph will 

automatically zoom to the times selected or b) click on the graph and drag a cursor box to define 

a zoom area (you can use either the left or the right mouse button to define the onscreen zoom 

area).  As soon as the mouse button is released the graph automatically zooms to the times 

specified by the cursor.  To return the graph to the original data press the Unlock T button.  You 

can select the zoom region on any of the displayed graphs and this region then applies to all of 

the graphs shown.    

Filter Control 

 Below the Zoom controls section is a filter spin button that controls the filter used during 

the calculation of velocity and dF/dt.  Derivatives calculated from actual data can be very noisy.  
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To reduce the noise a filter is built into the calculation of the derivatives.  We use a Savitsky-

Golay smoothing filter and the length of the filter can be selected using the Filter Length spin 

button.  A graphic visualization of the effect of the filter length can be seen on Figure 48 and 

Figure 49.  Observe the much smoother velocity and dF/dt data produced when the filter length 

is increased.  Details of the filter are provided in Appendix B – Savitsky-Golay Smoothing Filter.  

Frame Control 

 Below the Filter control is a Frame spin button that controls the Frame displayed on the 

screen.  If the protocol used to collect the data included a repeat function or multiple occurrences 

of Data Enable and Data Disable then multiple frames will have been created.  The Frame spin 

button allows the user to cycle through these frames displaying the data corresponding to each 

Data-Enable function. 

Auto Load Tests 

 The Auto Load Tests button is used to control the automatic plotting of data as it is being 

collected.  With the button depressed the Analysis window will automatically plot the most 

recently collected data.   

Lock T Interval 

 The Lock T Interval button is used to control the zoomed window when automatically 

plotting data as it is being collected.  With the button depressed and the graph zoomed into a 

particular time region then each subsequent data set will be plotted in the same time window.   

 

 
Figure 48 Filter Set to 1 
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Figure 49 Filter Set to 16 
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7.0 Scope 

 Scope provides a real-time output of up to two of the input or output signals in a separate 

window.  Scope starts running in the background as soon as the main program is started, even if 

Scope is not opened.  Scope includes a data buffer that allows the user to review the Scope data 

taken over the previous 4 hours.  Scope also includes controls to specify the variable to be 

plotted, the time base and the units.  A data collection function is also provided that allows data 

to be streamed to disk for as long as the Record function is active.  There is no time limit when 

recording Scope data to a file (other than the size of the hard drive).  Scope also includes controls 

to freeze the display and then scroll the display back and forth in time.  There is a data readout 

function as well.  Whenever the cursor is positioned in the graph area a text readout box appears 

in the upper right-hand corner of each plot.  This box shows the average value of the quantity 

being displayed at the location in time where the cursor is placed.  Scope data is sampled at 100 

Hz but the data rate for storage to a Scope data file can be varied from 1 to 100 Hz in set 

increments. 

 

 
Figure 50 Scope Screen 

7.1 File Menu 

 The Scope File menu contains two menu items, Open Log File and Close.  

Open Log File 

 This menu item opens a file dialog window that allows the user to enter a data file for the 

storage of Scope data, see Figure 51.   

Close 

 The Close menu item closes the Scope window. 
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Figure 51 Scope Log File Dialog Window 

 

7.2 Edit Menu 

 The Scope Edit menu contains three menu items, Show Controls, Cursor Readout and 

Color.  

Show Controls 

Show Controls is a toggle control that allows the user to hide or show the controls on the 

left side of the window.  Hiding the controls maximizes the data plotting area.   

Cursor Readout 

Cursor Readout is a toggle control that allows the user to hide or show the cursor readout 

located on the right side of the plot area.  The readout shows the value of each plotted variable, 

in the units selected for the current location of the cursor.   

 

7.3 Using Scope 

1) Start the ASI 600A program. 

2) Select Scope on the main menu and click on Open. 

3) The Scope window will open and data will start to be shown on the screen. 

4) Select Time Base to choose the amount of data shown on the screen.  The time base can 

vary from 10s to 60 min. 
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5) Select the Channel 1 and Channel 2 display buttons to choose the variable to be 

displayed.  Options are the same for both Channel 1 and Channel 2 and these include: 

Lin, Lout, Fin, Fout, Aux1, Aux2, and SL.  Note: selecting the same variable to be 

plotted as both Channel 1 and Channel 2 results in a single graph of that variable that 

uses the full plotting area.   

6) Select Lunits to set the Length display units. Choices include: um, mm, Lo, Lf and volts. 

7) Select Funits to set the Force display units.  Choices include: mN, N, gm, kg, Fmax, Pa, 

kPa, and volts. 

8) Select Sunits to set the Sarcomere Length display units. Choices include: um and SLo. 

9) Select Vscale to set the vertical scale to Auto or Fixed.  Auto will automatically scale the 

data to fit the screen.  Fixed allows you to set the vertical limits of the length and force 

graphs.  When Vscale is set to fixed you can enter the minimum L value in the left text 

box and the maximum L value in the right text box.  If Vscale is set to Auto then the text 

boxes will show the minimum and maximum length scale values that the program is 

using.  You can also enter the minimum F value in the left text box and the maximum F 

value in the right text box.  If Vscale is set to Auto then the text boxes will show the 

minimum and maximum force scale values that the program is using. 

10) Once a log file has been set using File→ Open Log File then this filename will be 

displayed in the text box beneath the Vscale controls.  Also after setting a log file the 

controls for starting and stopping logging and for choosing the data rate will be un-grayed 

as is shown in Figure 52. 

11) The Sample Rate box allows the user to select the data-sampling rate that is written to 

disk.  Note the Scope displays always runs at 100 Hz. but you can select lower sample 

rates for writing to a file.  The sample rate choices vary from 1 Hz to 100 Hz. 

12) Use the Start Button to start recording data to disk. 

13) When data is being logged the Start button changes to a Pause Button. 

14) Use the Freeze Time and Arrow buttons to first freeze the display and then use the left or 

right arrow buttons to scroll through the data collected in the past 4 hours (or since the 

program was started whichever is less).  Note: data starts being stored to the internal 

buffer as soon as the program starts.  If for example you opened Scope 15 minutes after 

starting the program, those first 15 minutes will be in the Scope display buffer.  In this 

case if you froze the scope display as soon as you opened Scope you would be able to 

scroll back in time through the data that was stored in the buffer since the main program 

started.  Although you can scroll back and see data collected in the past there is no 

provision for writing this data to disk.  You must start the scope logging function in order 

to collect data with scope. 

15) A Status Bar is located above the Freeze Time button that shows status information about 

Scope including error messages. 
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Figure 52 Scope Logging Enabled 
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8.0 Software Updates 

 This chapter provides a brief description of the procedure required to update to a newer 

version of the 600A program.   

   

Aurora Scientific Inc. is striving to make ASI600A the best program for the control and 

acquisition of muscle mechanics experiments.  We are pleased to receive user feedback about the 

program including suggestions for new features.  

 

New versions of 600A are available from our update website or via email or courier.   

 

http://www.AuroraScientific.com/update 

 

If you use our update website you will be asked for user and program information before the 

update can be downloaded.  Once you have received a new version of the program please follow 

the procedure listed below to upgrade your system.   

 

 

Do not update the software with the 600A program running. Close the program prior 

to proceeding with the update procedure. 

 

1. Navigate to the update website as shown in the link above. 

2. Enter the information requested and press the Find Updates! button. 

3. All available program updates will be listed, click on the desired update to download it.  

4. Once the file is downloaded close all open programs. 

5. Copy the supplied update file to the /home/asi directory.  

6. Click on the Installer icon on the desktop.   

7. Browse and select the update file. 

8. Press start and the installer will install the file.  You may be asked to log in as root during 

the installation phase.  If so then type the current root password and press enter (when the 

600A was shipped the root password was set as “root”, if you have changed it then enter 

the new password you created). 

9. After the installation is complete you may be asked to reboot the PC.  If so please do this 

before running the new version of the program. 

 

This completes the update procedure.  In order to check that the update has been installed 

start the program and click on Help→ About.  Compare the version number listed on the About 

screen with that shown in the update file name.  If they are the same then you have successfully 

upgraded to the latest program version.  If you experience any difficulties while updating your 

system please contact Aurora Scientific Inc. 

  

mailto:info@AuroraScientific.com
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9.0 Technical Support, Warranty and Repairs 

Aurora Scientific Inc. is dedicated to providing you with products that allow you to meet 

your research goals.  For this reason technical assistance is always free and will be available for the 

life of your product.  If you do have a problem with a product then please know that all ASI 

products are covered by a three year warranty covering both parts and labour.  If you need to return 

a product to us for repair then consult the final section of this chapter for returns information. 

9.1 Technical Support  

 Please don’t hesitate to contact us if you have any technical support issues.  Contact us by 

telephone, email, fax, or regular mail.   

 

 Address: Aurora Scientific Inc. 

   Technical Support 

   P.O. Box 2724 

   Richmond Hill, Ontario, CANADA 

   L4E 1A7 

 

 Phone:  1 905 727-5161 

 Toll Free: 1 877 878-4784 (North America) 

 FAX:  1 905 713-6882 

 E-mail:  TechSupport@AuroraScientific.com 

 Web site: www.AuroraScientific.com 

 

9.2 Warranty 

 Products manufactured by Aurora Scientific Inc. (ASI) are guaranteed to the original 

purchaser for a period of three (3) years.  Under this warranty, the liability of ASI is limited to 

servicing, adjusting and replacing any defective parts that are of ASI manufacture.  ASI is not liable 

to the customer for consequential or other damages, labour losses or expenses in connection with or 

by reason of the use or inability to use the products manufactured by ASI.   

 

 Guarantee of parts and components not manufactured by ASI shall be the same as the 

guarantee extended by the manufacturer of such components or parts.  Where possible such parts 

returned to ASI will be sent to the manufacturer for credit or replacement.  Ultimate disposition of 

these items will depend upon the manufacturer's decision.   

 

 All shortages must be reported within ten (10) days after receipt of shipment. 

 

 Except where deviations are specified in literature describing particular products, the limited 

warranty above is applicable to all ASI products, provided the products are returned to ASI and are 

demonstrated to the satisfaction of ASI to be defective. 

 

http://www.aurorascientific.com/contact/
http://www.aurorascientific.com/
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 Transportation costs of all products returned to ASI must be borne by the customer and 

products must be returned to ASI within three years after delivery to the original purchaser.  ASI 

cannot assume responsibility for repairs or changes not authorized by ASI or damage resulting from 

abnormal or misuse or lack of proper maintenance. 

 

 Repair or service work not covered under the limited warranty will be billed at current 

service rates.   

 

NO EXPRESS WARRANTIES AND NO IMPLIED WARRANTIES WHETHER FOR 

MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR USE, OR OTHERWISE 

OTHER THAN THOSE EXPRESSLY SET FORTH ABOVE WHICH ARE MADE 

EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES, SHALL APPLY TO PRODUCTS 

SOLD BY ASI, AND NO WAIVER, ALTERATION OR MODIFICATION OF THE 

FOREGOING CONDITIONS SHALL BE VALID UNLESS MADE IN WRITING AND 

SIGNED BY AN EXECUTIVE OFFICER OF ASI. 

9.3 Returning Products to Aurora Scientific Inc. for Repair  

There are a few simple steps that must be completed before returning your product to 

Aurora Scientific Inc. 

 

1. Obtain a Return Material Authorization number (RMA#). 

Contact our technical support department to obtain a RMA #.  We require the serial number 

of the product along with your contact information, i.e. your name, institution, phone 

number and email address. 

 

2. Package your instrument. 

Use the original packaging materials if available. If you do not have original packaging then 

ensure that the product is wrapped in bubble pack and placed in a sturdy corrugated 

cardboard box. If you are returning a force transducer please place the transducer head in the 

plastic protective box and then wrap the plastic box in bubble pack and place it in a small 

cardboard box which can then be placed in the larger box along with the electronics. For 

force transducer repairs we require both the transducer head and the control electronics. 

Please don't send the power cord. When returning a muscle lever system wrap the motor in 

bubble pack and place it along with the lever arm in a small cardboard box and then place 

that box in the larger shipping container along with the controller. For muscle lever repairs 

we require the motor, lever arm, motor cable and control electronics. Please don't send the 

power cord. 

 

3. Prepare Customs documents. 

Canadian Clients: no customs documents are required, skip to step 4. 

European Clients: no customs documents are required, skip to step 4 and ship to Aurora 

Scientific Europe. 

USA and Rest of the World Clients: You must include a Commercial Invoice (CI) with 

the shipment. Please click this link to download a blank CI. 

http://www.aurorascientific.com/contact/
http://www.aurorascientific.com/contact/
mailto:TechSupport@AuroraScientific.com?app=LeadgenDownload&shortpath=docs/CCI.pdf
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You can also prepare the commercial invoice yourself instead of using the downloadable 

form. Print the document on your company's letterhead and include the following 

information: Date, Shipper's Name, Address and Phone Number (your company 

information), Consignee's Name, Address and Phone Number (Aurora Scientific Inc. is the 

Consignee), Country of Origin of Goods (this will be Canada if you purchased the 

instrument from Aurora Scientific or USA if your product was purchased from Cambridge 

Technology), Conditions of Sale (include the following statement: GOODS RETURNING 

TO FACTORY FOR REPAIR, TEMPORARY IMPORT), Number of Packages (normally 

1), Description of Goods (e.g. Model 300B Muscle Lever System, Serial Number 1111), 

Quantity of Each Item (normally 1) and Value for Customs Purposes (the original purchase 

price of the instrument). 

Place three (3) copies of your CI in an envelope and mark the outside CUSTOMS PAPERS 

ENCLOSED. Attach the envelope to the outside of the box. 

 

4. Choose a shipper and prepare the waybill. 

European Clients: ship your instrument to Aurora Scientific Europe in Dublin, Ireland. 

All other Clients: ship your instrument to Aurora Scientific Inc. in Aurora, ON, Canada. 

You may ship your instrument back to us via the courier of your choice or via parcel post. If 

possible we prefer that you ship via FedEx. You are responsible for both the shipping and 

brokerage charges so please mark the waybill accordingly. Please don't ship freight collect. 

Shipments sent freight collect will be received but you will be invoiced for the shipping 

charges when your instrument is returned. 

 

5. Prepare and send a purchase order. 

After we receive the instrument we will evaluate it and contact you with the estimated repair 

cost. We require a purchase order before we can repair and return your instrument. Please 

fax or email us the purchase order at your earliest convenience. 

 

Return Shipping Address: 

 

 

Canada, USA, Asia 

 

 

Europe 

 

Aurora Scientific Inc. 

360 Industrial Parkway S., Unit 4 

Aurora, Ontario, CANADA  

L4G 3V7  

Attn: RMA Returns 

Tel: +1-905-727-5161 

 

 

Aurora Scientific Europe 

Hilton House 

3 Ardee Road 

Rathmines, Dublin 6, Ireland 

Attn: RMA Returns 

Tel: +353-1-525-3300 

 

http://www.aurorascientific.com/
http://www.aurorascientific.com/update
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Appendix A - ASI600A File Structure  

Data File Structure 
ASI 600A Data File 

Created: Wed Apr 15 05:49:35 2009 

A/D Sampling Rate: 1000 Hz 

Comment: Force Clamp 

*** Setup Parameters *** 

Length Controller: 315C 

Force Transducer: 403A 

Initial Length: 1 mm 

Diameter: 1.4 mm 

Maximum Tetanic Tension: 5 mN 

ADC0 Offset: 11 mv 

ADC1 Offset: 11 mv 

DAC0 Offset: 0.6 mv 

DAC1 Offset: 1.2 mv 

Length Units: mm 

Force Units: mN 

Time Units: s 

Scope Display1: 0 

Scope Display2: 6 

Scope Timebase: 0 

Scope Vscale:   0 

Scope Lunit:    3 

Scope Lmin:     0.004500 

Scope Lmax:     0.007000 

Scope Funit:    0 

Scope Fmin:     0.012000 

Scope Fmax:     0.026000 

*** Calibration Parameters *** 

Model  LOoffset  LOscale  LIoffset  LIscale  FOoffset  FOscale  FIoffset  FIscale 

Number  mm        mm/v    mm        mm/v     mN        mN/v     mN        

mN/v 

308B  0  0.2  0  0.2  0  1  0  1 

312C  0  0.15  0  0.15  0  1  0  1 

315C  0  0.15  0  0.15  0  1  0  1 

318B  0  0.3  0  0.3  0  1  0  1 

322C  0  0.3  0  0.3  0  1  0  1 

300B  0  0.5  0  0.5  0  50  0  50 

300B-LR  0  0.5  0  0.5  0  100  0  100 

305B  0  1  0  1  0  500  0  500 

305B-LR  0  1  0  1  0  1000  0  1000 

309B  0  1.25  0  1.25  0  2000  0  2000 

310B  0  2  0  2  0  5000  0  5000 

310B-LR  0  2  0  2  0  10000  0  10000 

400A  0  1  0  1  0  5  0  5 

402A  0  1  0  1  0  50  0  50 

403A  0  1  0  1  0  0.5  0  0.5 

404A  0  1  0  1  0  10  0  10 

405A  0  1  0  1  0  1  0  1 

406A  0  1  0  1  0  0.05  0  0.05 

407A  0  1  0  1  0  100  0  100 

other  0  1  0  1  0  1  0  1 

*** Test Protocol Parameters *** 

A/D Sampling Rate: 1000 Hz 

Comment: Force Clamp 

Minimum Length: 0.100 (Lo) 

Maximum Length: 2.000 (Lo) 

PD Deadband:    0.050000 mN 

Stimulus 01: 0.3 ms 100.000 Hz 10.0 ms 50.000 Hz 0.100 s 
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Stimulus 02: 1.2 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 03: 1.3 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 04: 1.4 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 05: 1.5 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 06: 1.6 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 07: 1.7 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 08: 1.8 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 09: 1.9 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 10: 2.2 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Time (ms) Control Function Options       

      5.0 Data-Enable   

     50.0 Length-Ramp  1.1  Lo  30  ms 

     85.0 Length-Sample  114  ms 

    100.0 Force-Step  0.2  Fmax 

    200.0 Length-Hold   

   1000.0 Length-Ramp  1  Lo  60  ms 

   1100.0 Data-Disable   

      0.0 Stop   

*** Force and Length Signals vs Time *** 

Time (ms)  Lin (mm)  Lout (mm)  Fin (mN)  Fout (mN) SL (um)   Stimulus/Triggers 

0.1 1.00005 1.00000 0.00015 4.99970 1.66519 0 

0.2 1.00005 1.00000 0.00015 4.99970 1.66519 0 

0.3 1.00005 1.00000 0.00015 4.99970 1.66519 0 

0.4 1.00005 1.00000 0.00015 4.99970 1.66519 0 

0.5 1.00005 1.00000 0.00015 4.99970 1.66519 0 

0.6 1.00000 1.00000 0.00015 4.99970 1.66519 0 

0.7 1.00005 1.00000 0.00015 4.99970 1.66519 0 

0.8 1.00005 1.00000 0.00015 4.99970 1.66519 0 

0.9 1.00005 1.00000 0.00046 4.99970 1.66519 0 

1.0 1.00000 1.00000 0.00015 4.99970 1.66473 0 

1.1 1.00000 1.00000 0.00031 4.99970 1.66473 0 

1.2 1.00000 1.00000 0.00015 4.99970 1.66473 0 

1.3 1.00000 1.00000 0.00015 4.99970 1.66473 0 

1.4 1.00005 1.00000 0.00015 4.99970 1.66473 0 

1.5 1.00000 1.00000 0.00015 4.99970 1.66473 0 

1.6 1.00000 1.00000 0.00015 4.99970 1.66473 0 

1.7 1.00005 1.00000 0.00015 4.99970 1.66473 0 

1.8 1.00005 1.00000 0.00000 4.99970 1.66473 0 

1.9 1.00005 1.00000 0.00015 4.99970 1.66473 0 

2.0 0.99995 1.00000 0.00000 4.99970 1.66473 0 

 

 

 
3.0 1.00005 1.00000 0.00015 4.99970 1.66519 0 

3.1 1.00005 1.00000 0.00015 4.99970 1.66519 0 

3.2 1.00005 1.00000 0.00015 4.99970 1.66519 0 

3.3 1.00005 1.00000 0.00015 4.99970 1.66519 0 

3.4 1.00005 1.00000 0.00015 4.99970 1.66519 0 

3.5 1.00005 1.00000 0.00015 4.99970 1.66519 0 

3.6 1.00000 1.00000 0.00015 4.99970 1.66519 0 

3.7 1.00005 1.00000 0.00015 4.99970 1.66519 0 

3.8 1.00005 1.00000 0.00015 4.99970 1.66519 0 

3.9 1.00005 1.00000 0.00046 4.99970 1.66519 0 

10.0 1.00000 1.00000 0.00015 4.99970 1.66473 0<-NOTE: Time changes from 3.9 ms to 

10.1 1.00000 1.00000 0.00031 4.99970 1.66473 0   10.0 ms because there were 

10.2 1.00000 1.00000 0.00015 4.99970 1.66473 0   two Frames in this data 

10.3 1.00000 1.00000 0.00015 4.99970 1.66473 0   record.  This occurs when  

10.4 1.00005 1.00000 0.00015 4.99970 1.66473 0   there are multiple  

10.5 1.00000 1.00000 0.00015 4.99970 1.66473 0   Data-Enable/Data-Disable 

10.6 1.00000 1.00000 0.00015 4.99970 1.66473 0   commands in a protocol or 

10.7 1.00005 1.00000 0.00015 4.99970 1.66473 0   when there is a Repeat 

10.8 1.00005 1.00000 0.00000 4.99970 1.66473 0   function in the protocol. 
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Protocol File Structure 
ASI 600A Test Protocol File 

Created: Thu Apr 26 23:21:59 2012 

A/D Sampling Rate: 20000 Hz 

Comment: Force Clamp 

Minimum Length: 0.900 (Lo) 

Maximum Length: 1.100 (Lo) 

PD Deadband:    0.000000 mN 

Stimulus 01: 0.3 ms 100.000 Hz 10.0 ms 50.000 Hz 0.100 s 

Stimulus 02: 1.2 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 03: 1.3 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 04: 1.4 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 05: 1.5 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 06: 1.6 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 07: 1.7 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 08: 1.8 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 09: 1.9 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Stimulus 10: 2.2 ms 100.000 Hz 20.0 ms 2.000 Hz 100.000 s 

Time (ms) Control Function Options 

      0.0 Data-Enable   

     90.0 Length-Sample  1 10010 ms 

    100.0 Force-Step   1.5 mN 

   2000.0 Force-Sine  20 Hz  0.2 mN  6 s 

  10101.0 Length-Hold  1 

  10200.0 Length-Ramp   1 Lo  300 ms 

  12000.0 Data-Disable   

  12001.0 Stop   

Sequencer File Structure 
ASI 600A Test Protocol Sequence File 

Created: Wed May 23 15:42:12 2012 

Protocol File Directory: /home/asi/pro/ 

Data File Directory: /home/asi/data/ 

Output File Type (0: one file 1: one file per frame): 0 

Protocol 1: 1 0 0 0 LengthSweep.pro LSTest1 

Protocol 2: 1 0 0 1 ForceClamp.pro FCTest1 

Protocol 3: 1 0 10 1 LengthRamp.pro LRTest1 

Protocol 4: 0 0 0 0   

Protocol 5: 0 0 0 0   

Calibration File Structure 
ASI 600A Calibration File 

Created: Wed May 23 10:08:10 2012 

Model  LOoffset  LOscale  LIoffset  LIscale  FOoffset  FOscale  FIoffset  FIscale 

Number  mm        mm/v    mm        mm/v     mN        mN/v     mN        mN/v 

308B  0  0.2  0  0.2  0  1  0  1 

312C  0  0.15  0  0.15  0  1  0  1 

315C  0  0.15  0  0.156935  0  1  0  1 

318B  0  0.3  0  0.3  0  1  0  1 

322C  0  0.3  0.000636329  0.315927  0  1  0  1 

300B  0  0.5  0  0.5  0  50  0  50 

300B-LR  0  0.5  0  0.5  0  100  0  100 

305B  0  1  0  1  0  500  0  500 

305B-LR  0  1  0  1  0  1000  0  1000 

309B  0  1.25  0  1.25  0  2000  0  2000 

310B  0  2  0  2  0  5000  0  5000 

310B-LR  0  2  0  2  0  10000  0  10000 

400A  0  1  0  1  0  5  0  5 

402A  0  1  0  1  0  50  0  50 

403A  0  1  0  1  0  0.5  0  0.5 

404A  0  1  0  1  0  10  0  10 

405A  0  1  0  1  0  1  0  1 
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406A  0  1  0  1  0  0.05  0  0.05 

407A  0  1  0  1  0  100  0  100 

other  0  1  0  1  0  1  0  1 

 

Setup File Structure 
ASI 600A Setup File 

Created: Wed May 23 15:42:12 2012 

Length Controller: 322C 

Force Transducer: 400A 

Initial Length: 5 mm 

Minimum Length: 0.5 Lo 

Maximum Length: 1.2 Lo 

Fiber Length: 5 mm 

Initial Sarcomere Length: 1.89 um 

Diameter: 1.183 mm 

Maximum Tetanic Tension: 5 mN 

PD Deadband: 0.0005 mN 

Calibrate FC step size:  10 um 

Calibrate FC ramp time:  20 ms 

Calibrate FC hold time:  50 ms 

Force Gain-Factor:       0.59 

Force Integral-Constant: 0.3 ms 

Force Filter-Constant:   0.2 ms 

Constant Stiffness Range: 100 

dF/dL measured at Force:  34275 adu 

Fiber Stiffness (adu):    1.15356 

Fiber Stiffness (mN/mm):  19.2261 

SL Gain-Factor:           0.25 

SL Integral-Constant:     0.1 ms 

SL Filter-Constant:       0 ms 

SL Stiffness (adu):       0.6 

SL Stiffness (um/mm):     1 

ADC0 Offset: 3.980 mv 

ADC1 Offset: 3.980 mv 

DAC0 Offset: -1.979 mv 

DAC1 Offset: 0.587 mv 

Panel 1 size: 2 

Panel 2 size: 4 

Panel 3 size: 2 

Panel 4 size: 1 

Panel 1 signal: 0 

Panel 2 signal: 1 

Panel 3 signal: 6 

Panel 4 signal: 6 

Background (0/1): 1 

Length In color:  895231 

Force  In color:  16717330 

SL     In color:  16771867 

Aux1   In color:  1769257 

Length Out color:  255 

Force  Out color:  255 

Stim   Out color:  16777215 

Aux2   In  color:  16747283 

Length Units: um 

Force Units: mN 

Time Units: ms 

Sarcomere Length Units: um 

Scope Display1: 0 

Scope Display2: 2 

Scope Timebase: 0 

Scope Vscale:   0 

Scope Lunit:    0 
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Scope Lmin:     4960.000000 

Scope Lmax:     5010.000000 

Scope Funit:    0 

Scope Fmin:     1.400000 

Scope Fmax:     2.400000 

Scope Sunit:    0 

Analysis Lunit: 0 

Analysis Funit: 0 

Analysis Tunit: 0 

Analysis Channels: 10100000000001 

Aux1 Name: Aux1 

Aux1 Units: volts 

Aux1 Scale (units/volt): 1.000000 

Aux1 Offset (units): 0.000000 

Aux2 Name: Aux2 

Aux2 Units: mv 

Aux2 Scale (units/volt): 1000 

Aux2 Offset (units): 0 

 

Analysis Export File Structure 
ASI600A Export Data File 

Created: Thu May 24 11:45:23 2012 

    Time        L in        F in     

    (ms)        (um)        (mN)     

       0.00    5001.770     2.14264  

       0.50    5001.860     2.14279  

       1.00    5001.840     2.14310  

       1.50    5001.800     2.14264  

       2.00    5001.880     2.14294  

       2.50    5001.840     2.14325  

       3.00    5001.920     2.14340  

       3.50    5001.900     2.14310  

       4.00    5001.910     2.14371  

       4.50    5001.910     2.14310  

       5.00    5002.000     2.14325  

       5.50    5001.960     2.14325  

       6.00    5001.950     2.14264  

       6.50    5001.910     2.14294  

       7.00    5001.950     2.14294  

       7.50    5001.960     2.14310  

       8.00    5001.920     2.14310  

       8.50    5001.880     2.14233  

       9.00    5001.930     2.14233  

       9.50    5001.840     2.14279  

      10.00    5001.890     2.14310  

      10.50    5001.850     2.14310  

      11.00    5001.860     2.14325  
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Appendix B – Savitsky-Golay Smoothing Filter  

The Analysis portion of the ASI600A program includes a smoothing filter for the 

calculation of velocity and dF/dt.  The filter is a Savitsky-Golay filter and it is described below.  

 

 

savgol:  Savitsky-Golay smoothing filter coefficients. 

  

Usage:  c = savgol fp d 

 

Remarks: Given a 3-element integer vector fp containing the parameters (nl, nr, M) and an 

integer scalar d, savgol returns a real vector c of length (1+nl+nr) containing the 

Savitsky-Golay filter of polynomial order M and derivative order d. The 

coefficients are returned in reverse order, and may be applied using conv2. 

  

The S-G filter is equivalent to fitting an M-th order polynomial to the points x[j] (j=i-

nl:i+nr), and taking the d'th derivative of the polynomial at j=i for i=0:N-1. 
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Appendix C – Terminology  

Lin  Length Input, analog voltage input from a length controller. 

Fin  Force Input, analog voltage input from a force transducer. 

AUX 1  Auxiliary Input, analog voltage input from auxiliary channel number 1. 

AUX 2  Auxiliary Input, analog voltage input from auxiliary channel number 2. 

Lout   Length Output, analog control voltage sent to a length controller. 

Fout   Force Output, analog control voltage sent to a force controller (only works with 

dual-mode length controllers). 

Stim Out  Stimulator Output, digital control signal sent to a stimulator that controls the timing 

of the stimulation pulses.  

Lref Reference Length, muscle tissue length when Lout is set to zero.  Units are mm. 

Lo Initial Length, tissue length under specified physiological conditions. Units are mm.   

Lf  Fiber Length, determined by the researcher. Units are mm. 

Do Effective Diameter, diameter of a circle that produces the same cross sectional area 

as the fiber.   

SLo Initial Sarcomere Length, sarcomere length under specified physiological 

conditions. Units are microns (um). 

Fmax  Maximum Tension, maximum force measured during a tetanic contraction. Units 

are mN. 

dF/dL  Derivative of Force with respect to Length, change in force for a given change in 

length. Units are mN/mm. 

Protocol  Test protocol consisting of commands that control data acquisition, stimulation, 

length and force of muscle tissue. 

Sequence  Series of Test Protocols run in succession. 

xterm X terminal, similar to a Windows command window.  An xterm allows the user to 

enter commands in the Linux operating system. 

RTAD  Real Time A/D device driver, the real-time code segment of the ASI600A program 

that handles all data acquisition and control signals. 
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Appendix D – Legacy Force Controls 

Legacy is the previous method of using force and SL control protocols. This system 

works with a less refined control algorithm and is thus less desirable compared to the new one. 

The purpose of this section is to explain how to update no longer functional protocols. 

 

 Old protocols will not behave the same on the new control system because parameters 

like gain factor, control factor, and damping factor which were previously set in the protocol are 

now in the Force and SL Control window, making them easier to modify and tune.  

 

These should be removed from the protocol as they are no longer functioning. The 

functionality of these parameters is moved to the Force and SL Control window, see section 5.0 

Force and SL Control for details.  
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Appendix E – Network Security  

Many users will elect to connect the ASI600A to a network.  Because the 600A is shipped 

with no login password and the root password is not secure, we strongly suggest that you 

set a secure user and root password before connecting the 600A to any network. A 

secure password should not be a recognizable word, it should be a minimum of 8 

characters containing letters (both upper and lower case), numbers and at least one special 

character (&, ^, $, #, @, !).   

 

Procedure to change the user password.  

1. Open an xterm console. 

2. Type  

passwd 

3. The user will be prompted to enter your current password. By default it is: 

asi 

4. The user will be asked to enter a new password. The minimum password length is 5 

characters; however we recommend a strong 8 character password. See warning above. 

5. Re-enter the password to confirm it. 

6. Record the password in a secure location so you do not forget. 

 

Procedure to change the root password (administrator password). 

1. Open an xterm console. 

2. Login as root. Type 

su 

3. The default password is root, if it has been changed then enter the current password, 

otherwise enter 

root 

4. Follow steps 2 through 6 of the procedure to change the user password in order to change 

the root password. 

 

 
Figure 53 Use passwd to Change the Root Password 
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Appendix F – Program Start Switches 

The program contains several start switches that are read when the program starts and set 

the program in different operating modes.  These start switches can be set by using the properties 

of the 600A icon.  To change the properties right click on the desktop icon and click on 

Properties.  When the Properties window opens click on the Application tab, then click on the 

Command line and then edit the line to enter the desired start switches.  Note: you must leave a 

space between each start switch if you intend to use multiple switches. 

  The following is the usage output when starting the program with the –h (help) switch. 

You can view the start switches by opening an xterm and typing: 

Asi600a –h 

 

-2 record 2 channels (the default) 

-4 record 4 channels 

-i    invert the polarity of Lout 

-p    limit Lout to -10:0 volts 

-s    enable serial i/o with HVSL for SL measurements 

-rt   enable rtpipe i/o with HVSL for SL measurements 

-b    enable the 802D Bath Controller commands 

-net [asihost]  enable logging and remote control from "asihost" 

-master    trigger slaves when 'Start Test' ... is clicked 

-slave     respond to triggers issued by masters 

-shiftsl   shift SL (in time) to correct for lags in video sl-measurements 

-sltodac1 [slmin slmax] output SL as analog voltage on dac1SL values from slmin:slmax 

(um) are mapped to -10:+10 volts 

 


